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Chapter 1

Intr oduction

TheSSHSecureshellfor WorkstationdVindows client (SSH2client) is aprogranthatallows securenetwork
serviceoveraninsecurenetwork.

The SSHSecureShellfor WorkstationsWindows client replacesther insecureerminalapplicationssuch
asTelnetandFTP. It allows you to securelyremotelogin to remotehostcomputersto executecommands
safelyin aremotecomputerandto provide secureencryptecandauthenticatedommunicationbetweertwo
untrustechosts.X11 connectiong@ndarbitrary TCP/IPportscanalsobe forwardedover the securechannel,
expandingSecureShell2’s usabilityevenfurther.

SecureShell 2 with its array of unmatchedsecurityfeaturesis an essentiatool for today's network envi-
ronment. It is a powerful guardianagainstthe numeroussecurityhazardshat nowadaysthreatennetwork
communications.

1.1 Network Security Risks

Theopenarchitecturef InternetProtocol(IP) makesit ahighly efficient, cost-efective,andflexible commu-
nicationsprotocolfor local andglobal communicationslt hasbeenwidely adoptednot only on the global
Internet,but alsoon theinternalnetworksof largecorporations.

IP was designedo be highly reliable againstrandomnetwork errors. However, it wasnot designedo be
secureagainsta maliciousattacler. In fact, it is vulnerableto a numberof well-known attacks. This is
preventingit from beingusedto its fullestfor businessandotherpurposesnvolving confidentialor mission-
critical data.

SSHSecure ShellWindows Client (© 2000SSHCommunicationSecurityCorp



12 Chapter 1. Intr oduction

1.1.1 Security of Inter net Protocol

TheIP protocolsuite,including TCP/IP,wasdesignedo provide reliableandscalablecommunicationsver
real-world networks. It hassenedthisgoalwell. However, it wasdesignedwentyyearsagoin aworld where
thelnternetconsistedf afew hundredcloselycontrolledhosts.ThesituationhaschangedTheInternetnow
connectdensof millions of computersgcontrolledby millions of individualsand organizations.The core
network itself is administeredy thousand®f competingoperatorsandthe network spanghewholeglobe,
connectedy fibers,leasedines, dialupmodemsandmobile phones.

Thephenomenagrowth of the Internethaspealedtheinterestof businessesnilitary organizationsgovern-
ments,andcriminals. Suddenlythe network is changingtheway businesss done. It is changingthe nature
of tradeanddistribution networksandtheway individual peoplecommunicatevith eachothet

The upsuge of businesscommunicationsscientific communicationgnd political communication®n the
Internethasalsobroughtout the usualneggative elements Criminalsarelooking for waysof gettinga cut of

theemeping businessindustrialespionagéasbecomeareality. Intelligenceagencieareshaving growing

interestowardsnetworkedcommunicationsandthey oftenexchanganformationwith domesticcommercial
interestandpolitical groups.Craclers,exchangingnformationandsourcecode make attackghattenyears
agowerethoughtto be only within thereachof superpavers’intelligenceagencies.

It hasturnedoutthatthelP protocol,while verytolerantof randomerrors,is vulnerableto maliciousattacks.
Themostcommontypesof attacksinclude:

e Eavesdroppinga transmissionfor example,looking for passwerds, credit cardnumbersor business
secrets.

e Hijacking, or takingoveracommunicatiorin suchaway thatthe attacler caninspectandmodify any
databeingtransmittechetweerthe communicatingarties.

¢ |IP spoofing,or fakingnetwork addressem orderto fool accesgontrolmechanismbasedn themor
to redirectconnectiongo afake sener.

The SSH2protocolis designedo protectnetwork communicationgigainsisecurityhazardsik e these.

1.2 Different SSHVersions

SeveraldifferentSecureshellclientandsenerversionsexist. Thedifferentversionsusedifferentimplemen-
tationsof the SSHprotocol.

SSHSecureShell for Workstationswindows client usesSSH protocolversion2 (SSH2),but supportsalso
connectiongo SSHversion1 (SSH1)seners. Note, however, that SSHversion2 (SSH2)is a more ad-
vancedprotocolthanthelegag versionSSH1.For moreinformationon usingan SSH1connectionseethe
SSHweb site http://www.ssh.com/products/ssh/ssh 1.html . Notethatwhenusingan SSH1
connectionmultiple terminalwindows andthefile transferoperationsarenot available.

(© 2000SSHCommunicationSecurityCorp SSHSecure ShellWindows Client



1.3. SSH2Protocol Features 13

The SSH2protocolprovidesa setof radicalimprovementdo SSH1.Theseimprovementsnclude:

1.3

A muchbetterunderstooddndmoresecureprotocol.

A new designwhich requiresmuchlesscodeto berunwith root privileges.

Totally rewritten codethatimprovessecurity

New routinesfor cryptographyandmathematicsiesultingin considerablémprovementsn speed.
Supportfor multiple public key algorithms,includingDSA andDiffie-Hellmankey exchange.
Easyto usefile transfersusingthe integratedfile transferagentin SSHSecureShell for Workstation

Windows client, andthe scp(Securdile copy) andSFTP(Securedrile TransferProtocol)applications
onUNIX.

SSH2Protocol Features

The SSH2protocolcontainghefollowing features:

Securgerminalsessionsitilizing secureencryption.

Full, secureeplacementor FTP andTelnet,aswell asthe UNIX r-seriesof commandsrlogin, rcp,
rexec.

Multiple high securityalgorithmsandstrongauthenticatioimethodghatpreventsuchsecuritythreats
asidentity spoofing.

Multiple ciphersfor encryption,includinge.g. 3DES,Blowfish andthe AES candidateT WOFISH.
Both passwerd andpublic key authentication.

Transparerandautomatidunnelingof X11 connectionandarbitraryTCP/IP-basedpplicationssuch
ase-mail.

Automaticand secureauthenticatiorof both endsof connection.Both the sener andthe client are
authenticatedb preventidentity spoofing,Trojanhorsesegtc.

Uniquegraphicalsecurdfile transferinterface(SFTP)fully integratedin theclientsoftware.

Multiple channelghatallow you to have multiple terminalwindows andfile transfersgoing through
onesecureandauthenticatedonnection.

SSHSecure ShellWindows Client (© 2000SSHCommunicationSecurityCorp



14 Chapter 1. Intr oduction

1.4 NewFeatures

Thisversionof SSHSecureShellfor Workstationwindows clientcontainsseveralnew featuresandenhance-
ments.

Someof themostnotablenew featuresarethefollowing:

Advancedauthentication method configuration
Any combinationof availableauthenticatioimethodscannow be selectedAlso the exactorderof the
methodscanbe configured.

Banner messagesupport

Theclientcandisplaya messagéeforeloggingonan SSHsener.

Commandline options

Host,usernameandport definitionscanbe passedscommandine optionsto the Windows client.

Command line tools

Separateommandine versionsof SCP2 SSH2andSFTP2areavailable.

Customization

Toolbarsmenusandshorcutmenuscanbe customizedreely.

DES support

If desiredalsothe DESlegagy ciphercanbeused(but the clientissuesa warningaboutthis).

FTP forwarding

FTPconnectiongannow be securelyforwarded.

Keyimport/export

Userkey pairsandhostpublic keys canbeimportedandexportedfrom/to any locationon disk.

Profiles

Differenthostsettingscanbe saved as profiles. This makesit extremelyfastandeasyto connectto
hostsrequiringdifferentconnectiorsettings.

Quick Connectoption

TheQuick Connectouttonallows fastaccesso a new connection.

SecurlID support

SecurlDauthenticatioris now supported.

SSH1forwarding

Also SSH1connectiongannow beforwarded.

(© 2000SSHCommunicationSecurityCorp SSHSecure ShellWindows Client



1.5. SystemRequirements 15

Terminal answerbackstring

Theanswerbacktringfor differentterminals(suchasansi,vt100,vt220,vt320andxterm)cannow be
selected.

Tunneling only option

Theclientcanbe configuredo disableterminalconnectionsallowing only tunnelsto be used.

Various bug fixes

This versionalsocontaingfixesfor variousminor bugsfoundon previousreleases.

1.5 SystemRequirements

The SSHSecureShell for WorkstationWindows client doesnot have any specialhardware or softwarere-
guirementsAny computercapableof runninga currentversionof the Microsoft Windows operatingsystem
(Windows 95, Windows 98, Windows 20000r Windows NT) andequippedwith afunctionalconnectiorto a
remoteUNIX or UN*X-lik e hostcomputercanbeused.

The SSHSecureshellfor WorkstationdVindows clientinstallationrequiresabout4 megabyteof disk space.
Notethat SSH2will sare eachusers settingdn thatparticularusers personatirectory

1.6 Desktoplcons

Whenyou have installedthe SSHSecureShellfor WorkstationdNindows client, you will have two separate
programiconson the Windows desktopaswell asin the Startmenu(by defaultunderStart-> Programs >
SSHSecureShell).

The SSH SecureShell Clienticon andthe SSH SecureFile TransferClient icon both startthe sameappli-
cation, SSH SecureShell for WorkstationsWindows client. The differencebetweenthe iconsis thatthey
usedifferentsettingdfiles. The SecureShellClienticon usesa settingdfile calleddefault.ssh2 , andthe
SecureFile Transfericon usesa settingdile calleddefaultsftp.ssh2

By default the settingsfiles have beenconfiguredso that they openthe appropriateSSH SecureShell for
Workstationswindow, eitherthe terminalwindow or the File Transferwindow. If you wantto changethe
default configurationyou cansare your settingsto eithera new settingdfile (usingthe Sase As optionfrom
theFile menu),or sarethenew settingsusingtheold settingdiles (usingthe Save optionfrom theFile menu).

Pleasenotethatwhenyou save your currentsettings,alsothe window positionsaresaved. If you openthe
SSHSecureFile Transferclient by clicking the appropriatdcon, thenopena terminalwindow or two, and
thensave the settingsthe’extra’ terminalwindows will appearthe next time you click the SSHSecureFile
TransferClienticon. If you thenclosetheFile Transferwindow andsare your settingsagain,the next time
youwill seeno File Transferwindow atall.

SSHSecure ShellWindows Client (© 2000SSHCommunicationSecurityCorp



16 Chapter 1. Intr oduction

Do not be alarmedby this - you canalwaysopena new terminalor File Transferwindow by clicking the
appropriateioolbarbutton or selectingthe appropriatemenuitem. If you thensare your settingsagain,the
new window positionswill be usedasdefaultvaluesfor new connections.

For moreinformationsaving the currentsettings seesection2.1 (Sasing Settings).

1.7 Support
The mostcurrentversionof the SSHSecureShell for WorkstationswWindows client online helpis available
onthe SSHWeb pageshttp://www.ssh.com/products/ssh/wi nhelp /.

Frequentlyasled questionspecificto the SSHSecureshellWindows clientareansweredn the SSHSecure
ShellWindows Client FAQ: http://www.ssh.com/products/ssh/faq .html

Links to thegeneralSecureShell FAQ mirror sitescanbe foundat http://www.ssh.org/faq.html

If the productdocumentatiorandthe FAQ do not answeryour questionsyou cancontactthe SSHsupport
service.Usetheonlinesupportform availableon http://www.ssh.com/support for supportrequests
andhttp://www.ssh.com/support/toolki ts/bug - repor t.htm | for bugreports.

1.8 Legallssues

The encryptionalgorithmsusedin the SecureShell 2 Windows client have beendevelopedin Europe,and
thereforethey arenot subjectto US export regulations. The SecureShell 2 Windows client canbe usedin
ary countrythatallows encryption includingthe United Statesof America.

Seethe LICENSING file for licensinganddistribution conditions.

SSH,SSH2andSecureShellareregisteredrademarksr trademarkef SSHCommunicationSecurityCorp.
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Chapter 2

Configuration

Before establishinga connectionto a remotehost computer,you shouldfirst checkyour connectionset-
tings. The connectionsettingscanbe changedy usingthe Profilesoption (seesection3.2 ( Profiles)),or
alternatvely by usingthe Settingsoption.

The Profilesdialogcanbe usedto configurethe profile settingsthatareassociatedvith a singleremotehost
computer With the Settingsdialogyou cancontrolalsothe global settingshataffectall connections.

To openthe Settingdialog,click the Settingsuttonon thetoolbaror selecthe Settingsoptionfrom the Edit
menu.

The differentsettingscategoriesarevisible on the left handside of the Settingswindow asa treestructure.
Brancheghathave a plus sign(+) next to themcanbe expandedy clicking on the plussign. Brancheghat
have aminussign(-) next to themcanbe collapsedy clicking onthe minussign.

Click on a branchto displaythe settingsassociatedvith it. You canchangethe settingsby changingthe
selectionglisplayedon theright handsideof the settingswvindow. Notethatsomeof the settingsdo nottake
effectuntil you openanew terminalor file transferwindow or starta new connection.

2.1 Saving Settings

Whenyou have changedhe settings an asterisk(*) is displayedon the SSHSecureShellfor Workstations
Windowsclienttitle bar,afterthe nameof thecurrentsetting<file (for example:default* ). Thisindicates
thatthe changedsettingsarenot yet permanent they have notbeensavedyet.

If youwantto make the changegpermanentyou cansave themfor lateruse. Click the Save button on the
toolbar, or selectthe Save Setingsmenuoption from the File menuto save arny changes/ou have madeto
your currentsettings.Thechangesvill be saredin the defaultsettingdfile, default.ssh2

Thedefaultsettingdile is loadedautomaticallywhenyou startthe SSHSecureShellclient. Thereforeall the

SSHSecure ShellWindows Client (© 2000SSHCommunicationSecurityCorp



18 Chapter 2. Configuration

settingghatyou sare in thedefault settingdile take effectimmediatelywhenyou runthe SSH2client. They
arealsousedfor connectionstartedwith the Quick Connecioption (seesection3.1 (Quick Connect)).

Notethatwhenyou save thecurrentsettingsalsothe positionsof the currentlyopenterminalandfile transfer
windows aresaved. If you arrangeyour window positionsto suit your own tasteandsave the settingsin the
default settingsfile, the windows will be automaticallypositionedthe way you wantthemwhenyou next

timerunthe SSHSecureShellclient.

If you spendalot of effort customizingyour own settingsit is a goodideato createbackupcopiesof your
customizedsettingsfiles andstorethemin a safelocation. This way you will not have to createthe custom
settingsagain,if youfor somereason(suchashardwarefailure)loseyour settingiles.

2.2 Multiple SettingsFiles

You cansave separatesettingsfiles for eachremotehostcomputer This canbe doneby usingthe Profiles
option. For moreinformationon usingprofiles,seesection3.2 (Profiles).

2.3 Loading Settings

It is easyto take into usea profile that hasbeensaved earlier Justselectthe Profilesoptions(from the
profilestoolbaror the File menu),andyou will seea menuof previously saved profiles. Click on a profile,
anda connectiorusingthe profile settingswill beimmediatelystarted.

Notethatthis alsoworkswhenyou arealreadyconnectedo aremotehostcomputer The profile will starta
new, separateonnection.

Anotherwayto loadthesettinggor aparticularconnectioris to doubleclickthesettingdile namefor example
in the Windows Explorer.Whenthe SSHSecureShellfor WorkstationaVindows clientis installed thefiles
with the extension.ssh2areassociatedvith the client. This meanghatyou canstartthe SSHSecureShell
for WorkstationdVindows clientwith ary settingsfile loadedby just doubleclickingon thatsettingile.

2.4 Profile Settings

With the Profile Settinggpageof the Settingsdialogyou canconfigureseparateonnectiorsettingsfor each
particularremotehostcomputer. To displaythe Profile Settings,openthe Settingsdialog andclick on the
Profile Settinggtext ontheleft handsideof thedialog.

User SettingsFolder

Thedirectorypathto your personabatafiles is displayedin thetext field next to the Browse button.
Notethatthisis notaneditablefield - thelocationof thesefilesis fixed.
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Figure2.1: TheProfile Settinggpageof the Settingsdialog.

Your personafiles includethe settingsfile (default namedefault.ssh2)your public andprivatekeys,
hostkeys andthe keyboardmappingfile (KEYMAP.MAP).

Click the Browsebuttonto quickly accesyour personablatafiles. Thefolder wherethe settingsfiles
aresavedwill appearThisis usefulif youfor examplewantto copy or backupyour personakettings.

Notethatyour privatekeys shouldalwaysbekeptsecret.Thisisimportantto remembeif youareshar
ing yourlocal computemwith otherusers.In suchcasejt is notadvisableo storeyour privatekeysin
thelocal disk. For moreinformationonthekey files, seesection3.6 (UsingPublicKey Authentication)

OK
Click the OK buttonto startusingthe specifiedsettings.

Cancel

Click the Cancelbuttonto abortary changeyou have madeto the settings.

Help

Click theHelp buttonto seetherelevanthelpsection.

2.4.1 Connection

Theprotocolsettingsusedin the connectiorareconfiguredusingthe Connectiorpageof the Settingsdialog.
Any changedconnectiorsettingswill take effectthenext time you login.
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Figure2.2: The Connectiorpageof the Settingsdialog.

Host Name

Typethe nameof theremotehostcomputemwhoseconnectiorsettingsyou wantto edit.

User Name

Typetheusernameyouwantto usewhenconnectingo theremotehostcomputer.

Port Number

Typethe port numberyou wantto usefor the SSH2connectionThedefault portis 22.

Authentication Methods

With the AuthenticationMethodslist you candefinea customauthenticatiormethodfor a host. With
theiconsdisplayedabove thelist you canadda new authenticatioimethod deleteanexisting authen-
tication methodand move the authenticatiormethodsupwardsor downwardsin the preferencdist.
Authenticatiormethodshigherupin thelist will be attemptedirst.

Encryption Algorithm

Selectthe desiredencryptionalgorithmfrom the dropdown menu.Valid choicesare3DES,Blowfish,
Twofish,Arcfour,andCAST128.You canalsoselecto usewhateverdefaultthatis usedby theremote
hostcomputeror createyour own customizedgoreferencdist of algorithms.For moreinformationon
thecustomoption,seesection2.4.2(CipherList).

MAC Algorithm

Selectthe desiredMAC algorithm (hashalgorithm) from the dropdavn menu. Valid choicesare
HMAC-MD5 and HMAC-SHAL. You canalso selectwhatever default thatis usedby the remote
hostcomputer.
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Compression

Selectthedesiredcompressiomsettingfrom the dropdavn menu.Valid choicesarezlib andnone.

Terminal Answerback
Selectthe desirecderminalanswerbackrom the dropdavn menu. Possiblechoicesare ansi, vt100,
vt102,vt220,vt320andxterm.

Connectthr ough Firewall
Checkthe checkboxif you are connectingthrougha firewall. For moreinformationon the firewall
settingsseesection2.5.7(Firewall).

RequestTunnelsOnly

Checkthe RequesfTunnelsOnly checkboxf wantto allow only tunnelsanddisableall terminalcon-
nections.

2.4.2 Cipher List

With the CipherList pageof the Settingsdialog you cancontrolwhich cipherscanbe usedin the connec-
tion. This selectiondefineswhatencryptionmethodswill be availablewhenusingthe custom encryption
algorithm.

Settings

8- P_rofile Settings
: - Connection

her List Configure the custom cipher list. Select algorithme and specify their
i o Keyboard order.
=- Tunneling
i - Dutgeing Cipher List: + +
‘- Incaming I0ES

EI G_Iobal Settings

= Appearance B|owfish
. Fant Tuwofizh
Calors Arcfour
Uzer Keys CAST128
Host Keys OoEs
File Transfer
Firewall
i Security
- Printing

| o | ot [ _n |

Figure2.3: Selectyour preferredencryptionalgorithmswith the CipherList page.

Thefollowing algorithmscanbe selected:
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3DES
Blowfish
Twofish
Ar cfour
CAST128

DES

Pleasenotethat DES is a legagy cipherthatis not consideredo be cryptographicallysecure. It is
strongly recommendethatDESis not used.If you selectto includeDESin thelist, awarningdialog
will bedisplayed.

Click the checkboxnext to eachalgorithmto includeor excludeit in thelist of availablecustomalgorithms.
An algorithmmarkedwith acheckmarks availablefor use.

You canalsoselectthe orderof preferencéetweerthe algorithms. Selectan algorithmby clicking it with
themouse andthenmove it upwardsor downwardsin thelist by clicking onthe Up or Down buttons.

The checkmarkdalgorithmsthatarelocatedon the top of thelist arepreferred. The SSHSecureShellfor
WorkstationswWindows client will first try to usethefirst checkmarkdalgorithmin the connection.If that
algorithmis not supportedoy the remotehostcomputey the client softwarewill try the next checkmarlkd
algorithmonthelist, andsoon.

To take your list of preferredencryptionalgorithmsinto use,selectcustom astheencryptionalgorithmon
the Connectiorpageof the Settingsdialog. For moreinformation,seesection2.4.1(Connection).

2.4.3 Keyboard

Thekeyboardsettingsusedin the connectiorareconfiguredusingthe Keyboardpageof the Settingsdialog.
The keyboardmappingstake effect immediatelywhenyou closethe Settingsdialog, without needingthe
restartthe connection.

BackspacesendsDelete
Checkthe BackspacesendsDelete checkboxif you wantto mapthe Backspacekey to the Delete
operation.

DeleteSendsBackspace
Checkthe Delete SendsBackspacecheckboxif you wantto mapthe Deletekey to the Backspace
operation.

Enter sendsCR + LF

Checkthe EntersendsCR + LF checkboxf youwantto mapthe Enterkey to sendthe carriagereturn
(CR)andline feed(LF) charactersOtherwiseonly theline feedcharactewill besent.
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Figure2.4: TheKeyboardpageof the Settingsdialog.

Lock Function Keys

Checkthe Lock FunctionKeys checkboxf youwantto lock thefunctionkeys.

Line Wrap
Checkthe Line Wrap checkboxf you wantthetext linesto wrapon the terminalwindow’s edge.By
default, line wrappingis on.

KeypadMode
Selecthow youwantthe numerickeypadon theright handsideof theregularkeyboardto function.
Numeric Keypad: Thekeypadis usedto type numbers.

Application Keypad: Thekeypadis usedfor applicationcontrol (with the keypadkeys functioningas
cursorkeys,Home,End,PageUp, PageDown, InsertandDelete).

2.4.4 Tunneling

Thetunnelingsettingsareconfiguredusingthe Tunnelingpageof the Settingsdialog. Any changedunneling
settingswill take effectthenext timeyoulogin.

The SecureShell 2 client can securelytunnel X11 connectiongrom the remotehost computerto an X-
Windows senerrunningonthelocal computer

Tunnel X11 connection
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Figure2.5: The Tunnelingpageof the Settingsdialog.

Checkthe TunnelX11 Connectiongheckboxo enablesecureX11 tunneling.

2.4.5 Outgoing Tunnel and Incoming Tunnel

Theoutgoingandincomingtunnelsettingsareconfiguredusingthe Outgoingpageandincomingpageof the
Settinggdialog,respectrely. Any changedunnelingsettingswill take effectthenext time youlogin.

Outgoing Tunnel

Outgoingtunnelsprotectthe datathatyour local computersendgo the remotehostcomputer

Incoming Tunnel

Incomingtunnelsprotectthe datathatyour local computeiis receving from theremotehostcomputer

Configuring Tunnels

Thefollowing buttonsareavailablefor configuringoutgoingandincomingtunnels.
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Figure2.6: The Outgoingpageof the Settingsdialog.
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Figure2.7: Thelncomingpageof the Settingsdialog.

Hemove

Help |

Add

Click the Add buttonto adda tunneldefinition. An Add New Tunneldialogappearsallowing you to
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definethe name type, listen port, destinatiorhost,anddestinationport of the tunnel. With outgoing
tunnelsyou canalsodefineif you allow local connection®nly.

Notethatif you aretunnelingan FTP connectionyou mustsetthetunneltypeasFTP.

Edit
Selecta tunneldefinitionfrom the displayedist andclick the Edit buttonto edit a previously defined
tunnel.An Edit Tunneldialogappearsallowing you to editthename listenport, destinatiorhost,and
destinatiorport of the outgoingtunnel. With outgoingtunnelsyou canalsodefineif you allow local
connection®nly.

Remove

Selecta tunneldefinitionfrom the displayedist andclick the Remave buttonto remove a previously
definedtunnel.Notethatthe selectedunnelwill beremoredimmediatelywith no confirmationdialog
beingdisplayed.

2.4.6 Outgoing Tunnel Definition

Thefollowing fieldsareusedto defineanoutgoingtunnel. Thesevaluescanbeeditedby clicking the Add or
Edit buttonson the Outgoingpageof the Settingdialog.

Add Hew Outgoing Tunnel |

Mame: ITunneI for POP3

Listen Port: I1 10
¥ Allow Local Connections Only

Destination Hogt; IprS.m_l,lisp.cnm Canizel

i

Destination Paort;, (100 Help

Figure2.8: Creatinganoutgoingtunnel.

Name
The nameof the tunneldefinition. You canusethis field to typein a descriptve namethatwill help
youto recognizehistunneldefinitionlateron.

Listen Port
Thisis thenumberof the portthatthetunnel’ listensto’, or captures.

Allow Local ConnectionsOnly

Leave a checkmarkin this box if you allow only local connectiongo be made. This meansthat
othercomputerswill not be ableto usethetunnelcreatedby you. By default, only local connections
areallowed. This is the right choicefor mostsituations. You shouldcarefully considerthe security
implicationsif you decideto allow alsooutsideconnections.
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Destination Host

Thisfield defineshe destinatiorhostof thetunnel. Thedefault valueis localhost

Destination Port

Thedestinatiorportdefinesnvhatportwill beusedin the destinatiorendof thetunnel.

2.4.7 Incoming Tunnel Definition

Thefollowing fields areusedto defineanincomingtunnel. Thesevaluescanbe editedby clicking the Add
or Edit buttons.

Add Hew Incoming Tunnel

Mame: IMy [ncoming Tunnel

Lizten Part; I

ok

Destination Host; IIDcthnst Cancel

[Drestination Part; I Help

il

Figure2.9: Creatinganincomingtunnel.

Name

The nameof the tunneldefinition. You canusethis field to typein a descriptve namethatwill help
youto recognizehistunneldefinitionlateron.

Listen Port

Theportthatthetunnel’listensto’, or captures.

Destination Host

Thisfield defineshe destinatiorhostof thetunnel. Thedefaultvalueis localhost

Destination Port

Thedestinatiorportdefinesvhatportwill beusedin the destinatiorendof thetunnel.

2.5 Global Settings

The global configurationsettingsare configuredusingthe Global Settingspageof the Settingsdialog. The
globalsettingsarecommaonfor all remotehostcomputers.
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Globalsettingsaresaved atthe sametime asthe profile settings. The global settingsarealwayssavedin the
userprofile directorywith thefilenameglobal.dat.

2.5.1 Appearance

Theappearancef the applicationandthe terminalwindow is configuredusingthe Appearanceageof the
Settingdialog.

Seltings
E| P_er”E Settings Appearance
i - Connection
: Cipher List Corfigure the appearance of the application.
i - Keyboard
i B Tunneling
; Outgoing
-~ Incoming v Show Add Profile Dialog when connected using Quick Connect

E| Global Settingz
E| Appearance
© e Fant

Calars Terminal Scrollback. Size: IEDDD

Uszer Keys

Hozt Keys

! Window Caption
File Transfer
! F"BWE_'" ¥ Dizplay Proils Name
e Security
- Prirting ¥ Display Host Name

Figure2.10: The Appearanc@ageof the Settinggdialog.

Cancel | Help |

Show Add Profile Dialog

Checkthe Shav Add Profile Dialog whenconnectedisingQuick Connecttheckboxo briefly display
the Add Profile dialogwhenconnectingo a remotehostcomputerusingQuick Connect.This allows
youto createa profile for the hostsimply by typing in the profile name.

Terminal Scrollback Size

Typein the TerminalScrollbackSizefield thenumberof linesthatyouwantto collectin thescrollback
buffer. The larger the value, the more you can scroll back the terminal displayto view the earlier
terminaloutput. The defaultvalueis 500lines.

Window Caption

TheWindow Captionsettingsaffectwhatis displayedn thetitle barof the SSHSecureshellfor Workstations
Windows clientterminalwindow andthe File Transferwindow.
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Display Profile Name

Checkthe Display Profile Namecheckboxto have the nameof the currentprofile to be displayedon
thetitle bar.

Display Host Name

Checkthe Display HostNamecheckboxto have the hostnameof the currentlyconnectedemotehost
computerto bedisplayedon thetitle bar.

2.5.2 Font

The font usedin theterminalwindow canbe selectedusingthe Font pageof the Settingsdialog. The new

font settingaffectstheterminalwindow immediatelywhenyou click the OK button. To discardthechanges,
click the Cancelbutton.

Settings
i Fort
¢ - Connection
: H Cipher List Select the font uged in the terminal window. The lizt displaps the
i - Keyboard non-propartional fonts installed on pour local computer,

i [E Tunneling .
: Dutgoing Fant Marne: Font Size:
- Incoming Terminal q

EI G_Iobal Settings
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Host Keyz
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Firewall

i Sty
Printing

Hr Lucida Conzole

H sshlinedrav

Hr S pstem APL Special
Hr Spstem VT Special

Terminal
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Figure2.11: The Font pageof the Settingdialog.

Font Name

Selectthe desiredfont from the Font Namelist. Thelist displaysthe non-proportiona(fixed-width)

fontsinstalledin your local computer Note that proportionalfonts are not suitablefor the terminal
window andthereforearenot availablefor selection.

Font Size

Selecthedesiredont sizefrom theFont Sizelist. Notethatthefont sizeaffectsthesizeof theterminal
window: thesmallerfontyou selectthesmallertheterminalwindow will be,andviceversa.However,
afterthis operatiornthe sizeof the terminalwindow canbe modifiedto suityourtastes.
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2.5.3 Colors

Thecolorsusedn theterminalwindow canbeselectedisingthe Colorspageof the Settinggdialog. Thenew
color settingsareactive immediatelywhenyou click the OK button. Note thatchangingthe terminalcolors

doesnot affect whatis alreadyvisible on the terminalwindow, but thetext outputfrom this point onwards
will usethesetcolorscheme.

To discardthechangesglick the Cancelbutton.
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- Cipher List
- Keyboard
=T unneling — Text Colors

g----Dutgoing Fareground: I. Black. vl Selection: ||:| Anua vI
“ [nzoming
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Select the color gettings used in the terminal window.

----- Forit
m r~ Cursor Color
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- Host Keyz
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- Security ¥ Enable &MSI Colors

support. Dizable it to only use

i Printing foreground and background colors.

— Reverse Colors

Reverse Video setting switches
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Figure2.12: The Colorspageof the Settingsdialog.

r Reverze Video

Text Colors

Thetext colorsaffecttheterminalwindow backgrounaolorandthecolor of text in bothaconnectedvindow
andadisconnecteavindow.

Foreground

Selectthe desiredforegroundcolor from the dropdavn menu. Foregroundcolor is usedfor text in a
window thathasaconnectiorto aremotehostcomputer Sixteencolorsareavailablefor your selection.
Blackis the default foregroundcolor.

Background

Selectthe desiredbackgroundtolor from the dropdavn menu. Sixteencolorsareavailablefor your
selection White is the default backgrounctolor.
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Selection
Usethedropdavn menuto selectthe color thatwill be usedasthe backgroundtolor whenselecting
text with themouse Sixteencolorsareavailablefor your selection.Tealis the default selectioncolor.
Disconnected

Usethedropdavn menuto selectthe colorthatwill beusedasthetext colorin aterminalwindow that
hasno connectiorto a remotehostcomputer.Sixteencolorsareavailablefor your selection.Grayis
thedefaulttext color for a disconnecteterminalwindow.

Cursor Color

Selecthedesiredcursorcolor from thedropdavn menu.Sixteencolorsareavailablefor your selection Blue
is thedefault cursorcolor.

ANSI Colors

With ANSI control codesit is possibleto changethe color of text in a terminalwindow. With the ANSI
Colorssettingyou canselectif you wantto allow this featureor not. Evenif you disableANSI colors,you
canstill selectyour favorite text andbackgroundolorsto beusedin theterminalwindow.

Enable ANSI Colors

Checkthe EnableANSI Colorscheckboxto allow ANSI colorsto be usedin theterminalwindow.

ReverseColors

By reversingthe displaycolorsyou canquickly changehedisplayfrom positive (dark on light) to negative
(light ondark)to improve visibility.

ReverseVideo

Checkthe ReverseVideo checkboxto changethe foregroundcolor into backgroundcolor andvice
versa.This settingaffectsthe wholeterminalwindow assoonasyou click the OK button.

2.5.4 UserKeys

The key pairsusedin public key authenticatiorcanbe managedisingthe UserKeys pageof the Settings
dialog.

Note thatyour privatekeys shouldalwaysbe keptsecret. This is importantto remembeif you aresharing
your local computemwith otherusers.In suchcasejt is not advisableo storeyour privatekeys in thelocal
disk. For moreinformationon thekey files, seesection3.6 (UsingPublicKey Authentication).
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Figure2.13: The UserKeys pageof the Settingsdialog.

GenerateNew K eypair

Click the GeneratéNew Keypair buttonto createa new public andprivatekey pair. Thiswill bringup

theKey GeneratioWizard. For moreinformationonthis procedureseesection3.3.1(Key Generation
Wizard).)

DeleteK eypair

Selectakey file from the privatekey file list andclick the Deletebuttonto deletethe key file from your
local computer

Export Keypair

Selectakey file from the privatekey file list andclick the ExportKeypair buttonto exportthekey pair.
A Selectrolderdialogwill open,allowing youto specifythetargetlocation.

Import Keypair

Click the Import Keypair button to import a keypair. The Import Keypair - SelectFiles dialog will
open,allowing youto locatethe keypairto beimported.

View Public Key

Selecta previously generategrivatekey file from the privatekey file list andclick the View Public
Key buttonto displaythe correspondingublic key. Thepublic key file will bedisplayedn Notepad.

ChangePassphrase

Selecta previously generatedprivate key file from the private key file list and click the Change
Passphrasbuttonto changehe passphrastr thekey.
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Upload Public Key

Clicking the UploadPublic Key buttonwhile connectedo a remotesener will automaticallyupload
the selectedpublic key. For more information on this procedure seesection3.5 (Uploading Your
PublicKey).

Private keyfile list

The privatekey file list shavs thefiles usedto storeyour privatekeys. The public keys arenot displayedas
they have the samefile namesasthe privatekeys, but they have .pubfor file extension.

Private Key File Name

ThePrivateKey File Namecolumndisplaysthefile namesof your privatekeys.

Comment

The Commentcolumndisplaysthe commentgif ary) associateavith your privatekeys.

2.5.5 HostKeys

The hostpublic keys usedin remotehostauthenticatiomprocessanbe managedisingthe HostKeys page
of the Settingsdialog. Thekeys arelistedin the hostkey file list.
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Figure2.14: TheHostKeys pageof the Settingsdialog.
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View
Selecta hostkey file from the hostkey file list andclick the View buttonto displaya hostkey. Alter-
natively you canjustdoubleclickonthekey file name.

Export Key

Selecta hostkey andclick the Export Key buttonto export a hostkey. The SelectFolderdialogwill
open,allowing youto specifythetargetlocation.

Import Key

Click the Import Key buttonto import hostkey. The Import Hostlkeys - SelectrFilesdialogwill open,
allowing youto locatethe hostkey to beimported.

Delete

Selecta hostkey file from thehostkey file list andclick the Deleteto deletea hostkey.

Host keyfile list

Thehostkeysin your possessioaredisplayedn the hostkey file list.

Host Name
TheHostNamecolumndisplaysthe hostnamesof your hostkeys.

Port

ThePortcolumndisplaysthe portsusedby the connectiongssociateavith eachhostkey.

File Name
TheFile Namecolumndisplaysthefile nameof eachhostkey file.
Fingerprint

TheFingerprintcolumndisplaysthefingerprintof eachhostkey file. Thefingerprintis representeds-
ing the SSHBabbleformat,andit consistof a pronounceablseriesof five lowercasdettersseparated
by dashes.

2.5.6 File Transfer

The default file transfersettingscanbe configuredusingthe File Transferpageof the Settingsdialog. The
new settingswill affectsubsequentlgtartedrile Transferwindows.

Show Root Folder
Checkthe Shav RootFoldercheckboxo shav therootfolderin the File Transferwindow by default.

Show Hidden Files
Checkthe Shav HiddenFilescheckboxo shav hiddenfilesin the File Transferwindow by default.
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Figure2.15: TheFile Transfempageof the Settingsdialog.

Confirm Delete
Checkthe ConfirmDeletecheckboxf youwantthe File Transferutility to askfor confirmationwhen
deletingdfiles or folders.

Confirm Overwrite
Checkthe Confirm Overwrite checkboxif you wantthe File Transferutility to askfor confirmation
whenyoutry to transferafile thatalreadyexistsin thetargetsystem.

CloseProgressDialog On Success
Checkthe CloseProgres®dialog On Successheckboxif you want that the Download and Upload
dialogscloseautomaticallywhenfinished.

Presewe Original File Time

Checkthe Presere Original File Time checkboxif you want that the transferredfiles retain their
originaltime anddatestampvalues.If this optionis not selectedthetransferrediles will be stamped
with thetime of thetransfer

Display Items by Using

With the Display Items by Using settingyou can selectthe default view for the File Transferwindow by
choosingoneof thefour possibleviews.

Largelcons
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Selecthelargelconsoptionto displaytheFile Transferfile view asalLargelconsview. Eachfile and
folder hasalargeicon associatedvith it, makingfor a clearanduncluttereddisplay

Small Icons

SelectheSmalllconsoptionto displaythe File Transferfile view asa Smalllconsview. Eachfile and
folder hasa smallicon associatedvith it. This makesit possibleto displayseveraltimesmoreitems
thantheLargelconsview.

List
Selectthe List optionto displaythe File Transferfile view asa List view. Eachfile andfolder hasa

smallicon associatedvith it, andthefiles andfoldersaredisplayedin onesinglecolumnunderneath
eachother

Details

Selectthe Detailsoptionto displaythe File Transferfile view asa Detailsview. Thefiles andfolders
are displayedwith a smallicon, their file name,file size,file type, their last modificationdateand
attributesvisible.

By clicking ontheName Size, TypeandModified sortbarslocatedontop of theFile view, youcansort
thefiles andfoldersbasedon their file name file size,file type andthe time they werelast modified.
Clicking the samesortoptionagainreverseghe sortingorder.

Notethatthesortfunctionis not casesensitve: uppercasetext is sortedtogethemwith lower casetext.

Thefile typeassociationarederivedfrom theyourlocal computer If you have definedanew file type
descriptiorfor files with a certainfile nameextension alsothefiles in theremotecomputerareshovn
to beof thatfile type. This makesit easyto recognizeparticularfile typesalsoon the hostcomputer

Missing File Association

The SSHSecureShellfor WorkstationsWindows client usesfile type associationgn the sameway asWin-
dows Explorerdoes. Whenyou doubleclicka file in the File Transferwindow, it will be openedusingthe
applicationwith whichits file type hasbeenassociated.

All file typesarenotassociatedvith any application.With this field you candefinewhatapplicationwill be
usedto openafile thathasnofile typeassociationThe defaultapplicationis Notepadwhichis areasonable
choicefor files containingtext.

To changethe default associatiorfor unknown file types,click the button next to the text field. A Select
Applicationdialogwill bedisplayedallowing youto selectthe desiredapplication.

Formatting string for file time

In the formattingstringfield you cantypeastringthatpresentdiow the time anddatestampsof thefiles are
displayedin the File Transferwindow. The defaultvalueis %¢ which meanghatthe dateandtime will be
presentedh theformatdefinedin the Windows countrysettingglocale).
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To changethe formatof thetime anddatestampsyreplacethe default valuewith a string consistingof some
of thefollowing charactecombinations.

%a

Abbreviatedweekdayname
%A

Full weekdayname
%b

Abbreviatedmonthname

%B

Full monthname
%c
Dateandtime representatioappropriatdor locale
%d
Day of monthasdecimalnumber(01 - 31)
%H
Hourin 24-hourformat(00- 23)
%l
Hourin 12-hourformat(01- 12)
%j
Day of yearasdecimalnumber(001- 366)
%m
Month asdecimalnumber(01- 12)
%M
Minute asdecimalnumber(00 - 59)
%p
Currentlocales A.M. / PM. indicatorfor 12-hourclock
%S
Secondasdecimalnumber(00 - 59)
%U

Weekof yearasdecimalnumberwith Sundayasfirst day of week(00 - 53)

%w

Weekdayasdecimalnumber(0 - 6; Sundayis 0)
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%W

Weekof yearasdecimalnumberwith Mondayasfirst day of week(00 - 53)

%X

Daterepresentatiofor currentlocale

%X

Time representatiofor currentlocale
%y
Yearwithout century asdecimalnumber(00 - 99)

%Y

Yearwith century asdecimalnumber

%z, %Z

Time-zonenameor abbreviation; no characters time zoneis unknowvn

%%

Percensign

2.5.7 Firewall

Thefirewall settingscanbe configuredusingthe Firewall pageof the Settingdialog. Thefirewall shouldrun
SOCKSversion4 software.

Firewall Name

Typethenameof thefirewall senerin the Firewall Namefield.

Port
Typetheport usedby thefirewall in the Portfield.

2.5.8 Security

The securitysettingscanbe configuredusingthe Securitypageof the Settingdialog.

Clear Host Name
Selectthe ClearHostNamecheckboxo avoid displayingthe previousremotehostcomputemamein
thelogin dialog.

Clear UserName

Selectthe ClearUserNamecheckboxo not displaythe previoususernamein thelogin dialog.
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Figure2.16: TheFirewall pageof the Settingsdialog.

Figure2.17: The Securitypageof the Settingsdialog.

Empty Clipboard on Exit

Selecthe EmptyClipboardon Exit checkboxo remove from the clipboardarythingthatwasrecently
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copiedusingthe cutandpasteEdit operations.

Empty Scrollback Buffer on SessiorClose

Selectthe Empty ScrollbackBuffer on SessiorClosecheckboxto emptyary remainsof theterminal
outputfrom the scrollbackbuffer.

SSH1Connections

FromSSHSecureshellfor WorkstationdVindows clientversion2.2.1onwards,you canconnecilsoto SSH
versionl (SSH1)seners. With the SSH1Connectionselectionyou candecideif youwantto allow SSH1
connectionsgery them,or issueawarningwhenconnectingo aremotehostcomputerthatis usingversion
1 of the SSHprotocaol.

SSHversion2 (SSH2)is a more advancedand secureprotocolthanthe legag/ versionSSH1. For more
informationon usingan SSH1connectionseethe SSHweb site http://www.ssh.com/products/
ssh/sshl.html

Notethatwhenusingan SSH1connectionmultiple terminalwindows andthefile transferoperationsarenot
available.

Allow

Selectthis optionto allow alsoSSH1connections.

Warn

Selectthis optionto issuea noticewhenan SSH1connectioris made.

Deny

Selectthis optionto disallov SSH1connections.

2.5.9 Printing

Theprint settingscanbe configuredusingthe Printingpageof the Settinggdialog. (Print Settingscanalsobe
selectedrom the File menuof theterminalwindow.)

Printer Font
Selectthefont andfont sizeto be usedin the printed output. Any non-proportionafont installedon
your systemcanbeselected.

Mar gins

Selectthe width of the blank borderaroundthe pageon printed output. The mamgins for the top,
bottom,left andright of the pagecanall be specifiedndividually. Thedefault valuefor all mamginsis
10 millimeters.
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Figure2.18: The Printingpageof the Settingsdialog.

Header & Footer
Selectwhatadditionalinformationappear®n the printedpages.

Title appearsat the top left of the pageanddisplaysthe title of the terminalwindow (for example:
remotehost - SSH Secure Shell ).

Dateappearsat the top right of the pageand displaysthe dateandtime whenthe pagewas printed
(for example: 07 December 2000, 05:47 ). Thedateandtime formatis the sameasusedin
Windows.

PageNumberappearstthebottomright of the page(for example:Page 1 of 2).

2.6 Customize

Selectthe Customizeoption from the View menuto modify the menuoptions,toolbars, menusettingsand
generakettings.

Notethatyou canhave only oneterminalwindow openwhenusingthe Customizeoption.

Click onthetabsonthetop of the dialogto switchbetweerdifferentpages:

Commandstab
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Figure2.19: Usethe Customizedialogto modify the userinterfacesettings.

Selectthe Commandgabto move individual menuoptions.Selectthe menucategory from the list on
theleft, andthenusethe mouseto dragmenuoptionsinto the menusor toolbarsdisplayedn the SSH
SecureShellwindow.

Toolbarstab

Selectthe Toolbarstabto definewhich toolbarsaredisplayedon the SSHSecureShellwindow.

If you have madeary changesyou can selectthe toolbarsyou want resetand thenclick the Reset
buttonto returnthe default toolbarconfiguration.Click the ResetAll buttonto resetall thetoolbars
andmenus.

Selecteitherthe Profilesor Toolbaroption andthencheckthe Shaw text labelscheckboxto display
text labelson thesetoolbars.Text labelsclarify thetoolbaricons,but alsotake up space.

Menu tab

Selecthe Menutabto definethe menusettings.
Click the Resethuttonto resetthe menugo their original configuration.

Usethe Context Menusdropdavn menuto display ary of the shortcut(or popup)menus:terminal
shortcutmenu,file transfershortcutmenul (displayedwhenyou do not have a file selected)r file
transfershortcutmenu?2 (displayedvhenyou have selectedafile). Thenyou canclick the Commands
tab and drag menuoptionsinto the shortcutmenus(and remove items from the shortcutmenusby
draggingthemoff themenu).

Usethe Menuanimationdropdavn menuto selectthetype of menuanimations Theavailableoptions
areNone,Unfold, SlideandFade.

Selecthe Menushadav checkboxo displayshadevs underopenmenus.
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Options tab
Selectthe Optionstabto changegeneraluserinterfaceoptions.

Selectthe Shav Screenips on toolbarscheckboxto display a shorthelp text, whenyou placethe
mousepointerover atoolbarbutton.

Selectthe Shav shortcutkeysin Screenips checkboxo seethe possiblekeyboardshortcutdisplayed
in additionto the shorthelptext.

Selectthe Largelconscheckboxo displaybig toolbaricons.
Selectthe Look 2000 checkboxto enableWindows 2000 style featuresin the userinterface. This
optionhasonly minimal effects,andit affectsmainly the styleof toolbarhandles.
Help
Click theHelp buttonto displaytheonlinehelp.

Close

Click the Closebuttonto stopthe customizatiorprocess.
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Connecting

SSH SecureShell for WorkstationsWindows Client makesit easyto establishconnectiondo newv remote
hostcomputersandto managehe settingsrequiredfor eachdifferenthost.

The Quick Connectoptionallows you to createnew connectiongast,minimizing the hassleassociatedvith
configuringeachconnection.lt is easyto definea profile for new hosts,andsare just theright settingsfor
each.

3.1 Quick Connect

Selectthe Quick Connectoption(from thetoolbaror from the File menu)to establiska completelynew SSH
connectiorthatcanbe operatedndependentlyof ary otherclientsandconnections.You canconnectto an
entirelynew remotehostcomputerandstill keeptheold connectiorto a differenthostopen.

The Connectto RemoteHostdialogwill open,automaticallyfilled in with the valuesdefinedin the default
configurationfile (default.ssh2 ). Thereforeit makessenseo usethe Settingsdialog (seesection2.1
(Saving Settings)to setthe mostcommonlyusedoptionsandsave themin thedefault.ssh2 configura-
tion file.

Whenyou needto establisha nenv connection,just click the Quick Connectbutton to connectto a nev
hostwith the default settings. When connectedyou canthen customizethe settingsto matchyour exact
requirementgor this particularhostandsare the settingsasthis host’s profile (seesection3.2 ( Profiles)).

But thereis an evenfasteralternatve. Whenyou login usingthe default settingsthe Add Profile dialog is
briefly andnon-intrusvely showvn. Click onthe dialogandwrite in the namefor the new profile. Whenyou
pressthe Enterkey, the profile is automaticallysaved. It is accessibldrom the Profilesmenu,andcanlater
befully customized.
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3.2 Profiles

If you habituallyconnecto morethanjust oneremotehostcomputersyou probablywantto have different
settingsdefinedfor eachhost. Profilesmake it easyto managelifferenthostconfigurations.

You canhave anunlimitedamountof differentprofilescustomizedor differentconnections.

Notethatthe SSHSecureShellfor WorkstationaNindows client considergheprofilesasthe users personal
dataandsavesthe profile definitionfiles in the personafolder of the user This meanghatevery userof the
local computercanhave his or herown profiles,without affectingotherusersof the samecomputer

Selectthe Profilesoption (from thetoolbaror the File menu)to eitheradda new profile definitionor editan
alreadydefinedprofile.

3.2.1 Add Profile

Adding a new profile is extremelyeasy Whenyou have connectedo a nev hostcomputey selectthe Add
Profileoption. The Add Profile dialogwill open.

Figure3.1: Justtypein a namefor thenew profile andyou areready!

Typeanamefor the profile (the nameof the hostcomputelis agoodchoice)andpressEntet You areready!

Whenyou laterwantto connecto the samehost,just selectits profile underthe Profilesoption. You will be
immediatelyconnectedwith all thesettingsn their properplaces evenincludingthe numberandpositions
of SSHSecureShellwindows.

By usingprofiles,you canhave just the right connectionsettingsfor eachhost,with no hassleor defining
complicatecconfigurationsettings.t’s thatsimple.

3.2.2 Edit Profiles

Click the Edit Profilesoption to modify profilesthat you have saved earlier The Edit Profilesdialog will
open,allowing youto editall the hostspecificsettingsassociateavith this particularconnection.

Click onthetabsonthetop of the pageto switchbetweerpages.For acloserlook on the settingsdisplayed
undereachtab,seesection®2.4.1(Connection)2.4.3(Keyboard),2.4.2(CipherList), 2.4.4(X11 Tunneling)
and2.4.5(0utgoingTunnelingandincomingTunneling).

You can make changego several profiles at the sametime by changingthe profile with the profile tree
displayedon theleft handsideof the Edit Profilesdialog.
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Figure3.2: UsetheProfilesdialogto customizesettingsfor eachhostcomputer

Whenyou arefinishedwith the settingsyou canclick the OK buttonto save the new profile definition,or the
Cancelbuttonto changeyour mind andabortyour changes.

Profiles Shortcut Menu

Click the profile treewith theright mousebutton,anda shortcutmenuwill open.

If yourightclick on a profile, you canselectfrom thefollowing options:

Connect

Selectthe Connectoption to immediatelyconnectto the remotehost computerassociatedvith the
profile.

Copy

Selectthe Copy optionto copy the profile definitioninto the clipboard. Now you canclick anempty
locationin the profile treeandpastea copy of theprofile there.

Cut

Selectthe Cut optionto remove the profile from its presentocationin the profile tree. Now you can
click anemptylocationin the profile treeandpastethe profile there.

Delete
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Selectthe Deleteoptionto remove the profile. A Confirm Deletedialogwill open,askingif you are
surethatyouwantto erasehe selectecrofile.

Rename

Selectthe Renameoptionto typein anew namefor the profile. It is agoodideato give eachprofile a
descriptve name sothatthe profilesareeasyto recognizdateron.

If yourightclick on anemptyspotonthe profile tree,you canselectfrom two options:

Paste

Selectthe Pasteoptionto pastea profile thatyou have copied.

New Folder

Selecthe New Folderoptionto createa new folderin the profile tree.

Organizing Profiles

If you have defineda long list of profiles,it may be a goodideato organizetheminto folders. Click the
profile list with theright mousebutton,andselectthe New Folderoptionto createa new folderin the profile
treestructure. Type a namefor thenew folder.

Now you can usethe mouseto drag and drop the profiles and arrangethem into folders so that you can
quickly find the profilesyou need.

Figure3.3: Creatinga new folderfor betterorganization.

3.3 KeyGeneration

If you are going to connectto a remotehost computerusing public key authenticationyou will have to
generatsg/our key pair beforeconnecting.

Publickey authenticatioris basednthe useof digital signaturesEachusercreates pair of 'key’ files. One
of thesekey filesis theusers public key, andthe otheris the users privatekey. The senerknowstheusers
publickey, andonly theuserhasthe privatekey.
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Whentheusertriesto authenticatderself thesener checksfor matchingpublic keys andsendsa challenge
to theuserend. The useris authenticatedy signingthe challengeusingherprivatekey.

Remembethatyour privatekey file is usedto authenticatgyou. Never exposeyour privatekeys. If anyone
elsecanaccesyour privatekey file, they canattemptto login to theremotehostcomputerasyou, andclaim
to beyou. Therefordt is extremelyimportantthatyou keepyour privatekey file in a secureplaceandmake
surethatno oneelsehasaccesdo it.

Do not usepublic key authenticatioron a computerthatis sharedwith otherusers.Generatekeys only on
your personatomputetthatno oneelsecanaccess!

In orderto usepublic key authenticationyou mustfirst generatg/our own key pair. You cangenerateyour
own key fileswith the helpof abuilt-in key generatiorwizard.

3.3.1 KeyGenerationWizard

To generate new key pair, openthe Settingsdialogandselectthe UserKeys page.Thenclick the Generate
New Keypair buttonto runthe key generatiorwizard.

The wizard will generatéwo key files, your private key andyour public key. The privatekey file hasno
file extension,andthe public key hasthe samebasefile nameasthe privatekey, but with .pub asthe file
extension.Thekey fileswill bestoredin yourlocal computerin the userprofile directory.

Figure3.4: TheUserKeys pagewith two key pairsalreadygenerated.
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3.3.2 KeyGeneration- Start

The Key Generation StartpagecontainsimportantinformationaboutsafetymeasuresReadthe text and
click theNext button.

Figure3.5: The Startpageof the key generatiorwizard.

3.3.3 KeyGeneration- KeyLength

OntheKey Generation Key Lengthpageyou candecidehow long (i.e. how complicated)you wantyour
keysto be. Long keys aremoresecurewhile usingshortkeysis somevhatfaster The default valuefor key
lengthis 1024bits.

UsetheKey Lengthdropdavn box to selectthe desiredkey length. Valid optionsare 768,1024,2048and
3072bits. Thenclick the Next buttonto startthe key generatiorprocess.

3.3.4 KeyGeneration- Generation

Onthe Key Generation Generatiorpagethe computemwill generateyour key files. This cantake several
minutes,dependingn the choserkey lengthandthe processospeedf thecomputer

During the key generatiorphasean animationof randombits is displayed. Whenthe processs ready the
Next buttonis ungrayedandyou canproceedo the next phaseby clicking it.
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Figure3.6: TheKey Lengthpageof thekey generatiorwizard.

Figure3.7: Key generationn process.

3.3.5 KeyGeneration- Enter Passphrase

On theKey Generation EnterPassphraspageyou canprovide informationdescribingthe generatekey
pair, andprotectthefiles with a passphrase.
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Figure3.8: Enteringa passphrasfor anewly generatedkey pair.

File Name

Typeanamefor thekey file in the File Namefield.

Comment

In the Commentffield you canwrite a shortcommenthatdescribeshekey pair - you canfor example
describehe connectiorthefiles areusedfor. Thisfield is not obligatory but canbe quite useful.

Passphrase

Typeaphrasehatyou have to enterwhenhandlingthekey. This passphraseorksin asimilarwayto
apassverd andgivessomeprotectionfor your privatekey.

Make the passphraséifficult to guess. Use at least8 characterspoth lettersand numbers. Any
punctuatiorcharacterganbe usedaswell.

Memorizethe passphrasearefully, anddo notwrite it down.

Passphrase

Typethe passphrasagain.This ensureshatyou have not madeatyping error.

Whenyou have typedin atleastthe file nameandthe passphraséwice), you canclick the Next buttonto
proceedo the next phase.
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3.3.6 KeyGeneration- Finish

TheKey Generation Finishpagedisplaysimportantinformationon theuseof thekey files.

Thenew public andprivatekeys have beengeneratedThey arecurrentlystoredon your local computer To
usethesekeysfor publickey authenticationyou have to uploadthe public keys to theremotehostcomputer.
If youareconnectedo aremotehost,you canautomaticallyhave a copy of your new public key uploadedo
thesenerby clicking onthe UploadPublicKey button. Thepublic key file canbeuploadedhtalaterdateas
detailedin the 3.5 (UploadingYour PublicKey) section.

Click the Finishbuttonto exit thekey generatiorwizard.

Figure3.9: Keys have now beengenerated.

3.4 Connectingto a RemoteHost Computer

To connecto aremotehostcomputer click the Connecicon on thetoolbar, selectthe Connectoptionfrom
theFile menu,or justhit Enteror Spaceonthekeyboardwhenthe(still disconnectedjlientwindow is active.
This bringsup the Connecto RemoteHostdialog.

Whenyou connectto a remotehostcomputerfor the first time, the hostwill provide your local computer
with a hostpublic key. The hostkey is the public key for identifying the remotehostcomputerthatyou're
connectingo.

This procesawill bringuptheHostldentificationdialog.
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3.4.1 Hostldentification Dialog

Whenyou connecto aremotehostcomputeifor thefirst time usingpublic key authenticationthehostsends
your local computetits publickey in orderto identify itself.

To help you to verify the host’s identity, the Host Identificationdialog displaysa fingerprintof the hosts
public key. Thefingerprintis representedsingthe SSHBabbleformat,andit consistof a pronounceable
seriesof five lowercasdettersseparatethy dasheslf you have reasoro suspecthatthepublickey you have
recevedmaybeforged,you canfor examplephonethe systemadministratoof theremotehostmachineand
checkif thefingerprintis correct.

If yourwork requireghe strictestdegreeof absolutesecurityandyou cannottrustthe network thatwasused
to deliverthehostkey, you canaskthe systemadministratoiof theremotehostcomputerto deliverthehosts

public key to you personallyfor exampleon a diskette. This way the key is never passedver the network

andyou canbe absolutelysurethatit hasnot beenforged. Whenusingthat hostkey with an SSHSecure
Shellconnectionyou canbe surethatyou areconnectingo the correcthostandthatthereis no possibility

of outsideintrusion.However, for ordinaryusethis procedurecanbe seenasoverkill.

The Hostldentificationdialog asksif you wantto storethe hostkey onyourlocal computer If you connect
regularly to thehost,you’ll probablywantto keepthekey. This preventsanattackwheresomeoneansteal
your connection.

Figure3.10: TheHostlIdentificationdialog.

Yes

You cansave thehostkey to thelocal databaséy clicking Yes.

No

You cancontinuewithout saving the hostkey by clicking No. If you choosenot to save the hostkey
locally, youwill beasledto the make this selectionagainnext time you connecto this host.

Cancel

You canalso cancelthe connectionby clicking on the Cancelbutton. This causesan authentication
failure,andthe connectiorwill becanceled.
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Help

Click theHelp buttonto view the online help.

If you save the hostkey, you do not have to go throughthis procedureagainthe next time you login. The
hosts publickey will still bechecledwith eachconnectionput thiswill be doneautomaticallywithoutuser
intervention.

Theknown hostkeyswill besavedin alocal databas¢hatis specificto eachuserof thelocal computer This
way eachuserwill build apersonabatabasef the public keys of known andtrustedhosts.

3.4.2 Connectto RemoteHost Dialog

The Connectto RemoteHost dialog allows you to specifythe hostname(or IP address)username,port
numberandauthenticatiomethodfor thenew connection.

Figure3.11:dentify yourselfto the remotehostcomputer

Theclientremembergour previous connection.lf you aregoingto reconnecto the samehost,you do not
have to typein all of thesamenformationall overagain.

Host Name
Enterthe name(or IP addresspf the remotehost computerin this field. Unlessthis is your first
connectionthe Host Namefield shavs the nameusedin the previous connection. If you want to
connecto thesamecomputeraspreviously, you do not have to editthisfield.

UserName
Enteryour usernameasusedin the remotehostcomputer. Unlessthis is your first connectionthe
UserNamefield shavs the nameusedin the previous connection.If you wantto connectusingthe
sameusernameaspreviously, you do not have to editthis field.

Port Number
Type the numberof the port usedin the connectionin the Port Numberfield. The port usedin the
previousconnectioris alreadyfilled in.

Authentication Method

Selectthe desiredauthenticatiormethodfrom the pulldown menu. Possibleauthenticatiormethods
arePassvord, PublicKey, SecurlDandCustom.
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Passwvord
Whenyou login usingpassverd authenticationyou will have to type your passverd eachtime
you establisha new connectiorto theremotehostcomputer

Public Key

Publickey authenticatioris basedn the useof digital signaturesl!f youwantto usepublic key
authenticationfirst youwill needto createa pairof 'key’ files (seesection3.3(Key Generation)).

Beforeyou canlogin usingpublic key authenticationyou have to uploadyour public key to the
remotehostcomputerseesection3.5 ( UploadingYour PublicKey)).

For moreinformationon the useof public keys, seesection3.6 (Using Public Key Authentica-
tion).
SecurlD

UsingSecurlDauthenticatiomequireshatyou have a SecurlDdevice thatgeneratethe numeric
codeghatareneededo login.

Custom

The customauthenticatiormethodcan be definedusing the Connectionpageof the Settings
dialog(seesection2.4.1(Connection)).

Connect

Click the Connecthuttonto connecto theremotehostcomputer.

Cancel

Click the Cancelbuttonif you changeyour mind andwantto abortthe connection.

3.5 Uploading Your Public Key

If you wantto usepublic key authenticatiorwhen connectingto the remotehost computer,you have to
uploadyour public key to thehost. If you have not yet generategrour own public key, seesection3.3 (Key
Generation).

Publickeys canbe uploadedautomaticallyto a sener. After a connectiorhasbeenmadeto aremotehost,a
UserKeypair canbe selectedrom the UserKeys settingsscreen Clicking on the UploadPublicKey button
will displaythedialogboxbelowv beforeautomaticallyuploadingthe publickey to the specifieddirectoryand
addinganentryfor it to theauthorization file.

If you do not usethe automaticuploadfacility, you will needto placeyour public key file in the .ssh2
subdirectoryin yourhomedirectoryontheremotehostcomputer Theauthorization file residingin the
.ssh2 directorymustbeeditedto take the newly transferredkey into use.

Destination Folder

Thisisthesubdirectoryonthesenerwherethepublickey file will beuploadedo. If thisdirectorydoes
not exist thenit will be createdunderyour homedirectoryonthe sener. e.g. "username/.ssh2
Thedefaultvalueis .ssh2
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Figure3.12: The UploadingPublicKey dialog.

Authorization File

Thisis thefile onthesenerthatcontainsdetailsof your public keys.. If thisfile doesnot exist thenit
will becreatedThedefaultvalueis authorization

View Authorization File

Checkingthis box will allow you to view andedit the authorization file beforeit is uploadedo
thesener.

3.5.1 Manually Copying the KeyFile

Theeasiestvayto manuallycopy yourpublickey file isto openthe Profile Settinggpageof the Settinggialog
(selecthe Settingsoptionfrom the Edit menu)andto click the Browsebuttonnext to the UserSettingg-older
field.

The folder containingyour usersettingsis opened.The folder containsa subfoldercalledUserkeys. Dou-
bleclick onthe UserKeys folder to openit.

Thefolder containingyour userkeys is opened.Selectthefile that containsthe public key thatyou wantto
copy to theremotehostcomputer.Note thatthe public key hasthefile extension.pub . Be carefulthatyou
copy thefile with the.pub extension,andnot a similarly namedfile without afile extension(which would
beyour privatekey thatyou have to keepsecure)!

Copy thefile to theWindows clipboardby pressingControl+C  onthekeyboardor by clicking thefile icon
with the right mousebuttonandselectingCopy from the shortcutmenu.

Now connectto the remotehost sener and opena file transferwindow, as describedn chapter5 (File
Transfer).

Your homedirectoryshouldcontaina subdirectorynamed.ssh2 . If you do not seethe.ssh2 directory
checkthatyou have the Shav HiddenFilesoptionselectedrom the View menu.
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Enterthe.ssh2directoryandcopy thekey file therefrom the clipboard(pressControl+V  onthekeyboard
or click theright mousebuttonandselectPastefrom the shortcutmenu).

3.5.2 Manually Editing the Authorization File

After you have uploadedyour public key to the remotehostcomputer,connectto the hostusingthe SSH
SecureShell client’s terminalwindow. Your homedirectoryshouldcontaina .ssh2subdirectory(notethat
thefirst characteof thefolder nameis afull stop).

First malke surethat your currentdirectoryis your homedirectory Type the following commandafterthe
remotehostcomputercommandoromptandpressthe Enterkey:

cd

Thenenterthe.ssh2subdirectonby issuingthe following commandafterthe commandorompt:

cd .ssh2
The .ssh2directoryshouldcontaina text file calledauthorization . You have to edit thatfile andadd
your public key file nameon a separatdine in thatfile. If theauthorization file doesnotyet exist, you

will createt now.

Startyour favorite text editor by typing authorization asa parameteafterthe nameof thetext editor.
For example,f yourfavoritetext editoris Pico,typethefollowing aftertheremotehostcomputerscommand
prompt:

pico authorization

Whenin thetext editor, adda new line containingthe word key , a spaceandthe public key file name.For
example,if thepublickey file nameis public _key.pub , addthefollowing line to theauthorization
file:

key public_key.pub

Now save the authorization file andexit the text editor Whenyou login the next time, public key
authenticatiorshouldbe working. If it is not, checkthatyou have typedthe public key file namecorrectly
in the authorization file, andthatthe correctpublic key file is locatedin the .ssh2 directoryon the
remotehostcomputer.
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3.6 UsingPublic Key Authentication

Whenyou connectto a remotehostcomputerusingpublic key authenticationyou will first seethe Connect
to RemoteHostdialog. Whenyou hit the Enterkey, public key authenticatiorwill be attemptedandif that
failstheclientwill try passverd authentication.

If thereis a suitablepublic key, the EnterPassphraséor Private Key dialog shouldbe shavn. This dialog
indicateghattheremotehostcomputeiis willing to acceptyour public key to authenticatgou. If youdo not
seethe EnterPassphraséor PrivateKey dialog, checkthatyou have properlyuploadedyour public key, as
describedn section3.5 (UploadingYour PublicKey).

Typein the passphrasassociatedvith thiskey. You definedthe passphrasehenyou createthe publickey -
seesection3.3.5(Key Generation EnterPassphrasepr moreinformation.

(If youagainjustpressgheEnterkey, thekey will notbeusedandthesystemwill askyourpasswerdinstead.)
If you enterthe correctpassphrasgiouwill connecto theremotehostcomputer

Notethatin somecaseghe remotehostcomputemay be configuredto useboth public key authentication
andpassword authenticatiorior increasedecurity In thatcaseyou will first haveto typein your passverd,
andafterthatto alsousepublic key authentication.

The authenticatiorsequencebove assumeghat the client is configuredto useary 2.4.1 (authentication
method).

3.7 CommandLine Options

For somepurposest may be usefulto operatehe SSHSecureShellfor WorkstationsWindows Client from
thecommandine (commandprompt).

The SSHSecureShellclientcommandine syntaxis:

sshclient [-r] [(p port] [-u wuser] [-h host] [profile.ssh2]

Thefollowing commandine optionscanbeusedto definethe connectiorparameters:

The-r optionwill resetall customizationgnadeto the userinterface(toolbarsandmenus).A confir-
mationdialogwill bedisplayed.
-p [port _-number ]

The-p optionspecifieghe port numberusedfor the connectionlf this optionis notspecifiedthe port
numberdefinedin the default profile will beused.
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-u [user_-name |
The-u option specifieghe usernamefor the connectionIf this optionis not specifiedthe username
definedin the default profilewill beused.

-h [host.name ]
The-h option specifieghe hostnamefor the connectionlIf this optionis not specified the hostname
definedin the default profilewill beused.

[profile.ssh2]

If aprofile is specified,it mustthe lastoption on the commandine. Any commandine parameters
will overridethe profile settings.If no profile is specified the default profile (default.ssh2 ) will
beused.

For example,the following commandwvould immediatelystarta connectiorto a hostcalledremotehosaind
connectas guest. The port numberis not specified,so the connectiorwould usethe port specifiedin the
defaultprofile.

sshclient -h remotehost -u guest

Thefollowing commandvouldimmediatelystarta connectiorto remotehostisingthesettingsdefinedn the
profile file custom.ssh2

sshclient -h remotehost custom.ssh2

If the hostis not specified(usingthe -h option) andno profile is specified the login dialogwill open,auto-
maticallyfilled with the valuesspecifiedon thecommandine.

For example thefollowing commandwvould displaythelogin dialogwith theportnumberalreadydefinedas
222andtheusernameasguest.

sshclient -u guest -p 222

Several othercommandine utilities are shippedwith the Windows client. For more information, seethe
appendice$10 (appendices)).
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Chapter 4

Terminal Window

The terminalwindow is a securereplacementor Telnetconnectionslt offersa commandine interfaceto
theremotehostcomputer.Note thatthe mostimportantfunction of the terminalwindow is to allow you to
operateheremotehostcomputer Thereforethe terminalwindow doesnot capturesomecommonkeyboard
shortcutgsuchasCtrl+C for copy), but passesheminsteado theremotehostcomputeywherethey canbe
usedto controlremoteprogramexecution.

Apart from the text displayitself, a lot of connectioninformationis visible in title and statusbarsof the
Terminalwindow.

Figure4.1: The Terminalwindow.

4.1 Terminal Window Title Bar

Thetitle baris locatedon thetop of thewindow.

The leftmostitem on thetitle baris thewindow icon. Click it to displaythe window menuor doubleclickit
to closethewindow.

The next item on the title baris the window’s sequencenumber. This helpsyou to distinguishbetween
differentwindows usingthe sameconnection.
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Next onthetitle baris displayedheremotecomputershostname.For example asecondvindow associated
with a connectiorto a hostcomputercalledremotewould displayas2:remote

After the hostname the next item on thetitle baris the nameof the settingsfile in use.If you arenotusing
a settingsfile thathasbeensaved with a specificfile name(usingthe Save As option on the File menu),a
settingdile calleddefault isin use.

Thelasttext item onthetitle baris thenameof theclient, SSHSecureShell.

4.2 Terminal Window StatusBar
Thestatusbaris locatedat the bottomof the Terminalwindow. Whenbrowsingthroughthe menuoptionsor
toolbarbuttons,the statusbardisplaysa shortcontet sensitve helptext.

When the menusor toolbarsare not browsed, the left side of the statusbar indicatesto which remote
hostcomputeryou are currentlyconnected.If you arenot connectedthe statusbar displaysthe text Not
connected - Press Enter/Space to connect .

Thenext statusbarfield shavs the currentprotocolversion,encryptionalgorithm,andMA C algorithmsepa-
ratedby dasheg¢for example:SSH2 - 3des-cbc - hmac-md5). Notethatthestatusbardisplayssome
of thealgorithmnamesdn alongerform thanthe Connectiorscreerof the Settingdialog.

The next field displaysthe numberof columnsandrows of the terminalwindow. If you changethe size of
theterminalwindow, thiswindow sizeindicatorwill beimmediatelyupdated.

Thenext field displaysthetext CAPIf your CapsLock key is currentlyon.

Thelastfield of theterminalwindow statusbardisplaysthetext NUMf your Num Lock key is currentlyon.

Figure4.2: Terminalwindow statushar.

4.3 Terminal Window Shortcut Menu

Click theterminalwindow with theright mousebuttonto displaya shortcutmenu.By default, the following
menuoptionsareavailable:

Copy
Copy text into the Windows clipboard.

Paste

Pastetext from the Windows clipboard.
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PasteSelection

Copy the currently selectedtext into the cursorlocation without first copying it into the Windows
clipboard.

SelectAll
Selectall of thescrollbackbuffer.

SelectScreen

Selectall text currentlydisplayedon thescreenTherestof the scrollbackbuffer will notbeselected.

SelectNone

Cancelthecurrentselection.
Find
Searchfor text from the scrollbackbuffer.

New Terminal

Openanew terminalwindow.

New File Transfer

Openanew File Transferwindow.

CloseWindow

Closethe currentwindow.

Settings
Openthe Settingsdialog.

Theavailableoptionscanbe configuredusingthe Customizedialog (seesection2.6 (Customize)).
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Chapter 5

File Transfer

TheSecureshell2 Windows clientmakesit easyandcorvenientto transfeffiles betweeryourlocalcomputer
and the remotehost computer. You can uploadand downloadfiles by using an intuitive, graphicaluser
interfacesimilarin functionalityto the Windows Explorer.

You canopenthe File Transferwindow by clicking onthe New File TransferWindow buttonon the Secure
Shell2 toolbar,or by selectinghe New File Transferoptionfrom the Window menu.

The SecureShell 2 File Transfercontainsseveral uniquefeatureshat make securetransferoperationdast
andeasy

Note, however, thatthe SSH SecureShell for WorkstationswWindows client is not just an alternatve to an
FTPclient. You cannotfor exampleusethe SSH2clientto login to anormal,insecuré=TPhost. Theremote
hostcomputemustberunningan SSH2sener.

Figure5.1: TheFile Transferdialog.
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5.1 Drag And Drop Operations

You canusedraganddrop mouseoperationgo copy andmove files to andfrom the remotehostcomputer

Thisworksin a similarfashionto thestandardVindowsdraganddropoperationslf you hold down the Shift
or Controlkeys whenselectingdfiles with the mouse you canselectmultiple files and copy themall at the
sametime. If you hold down the Shift key, all thefiles andfoldersbetweerthefirst andlastselectionwill be
selectedIf you hold down the Controlkey, you canselectindividual files andfoldersoneby one.

If you doubleclicka file, the file will be openedby using a customapplication. (Notepadwill be used
by default.) For moreinformation on specifyingthe customapplication,seesection2.5.6 (Missing File
Association).

5.2 Multiple File Transfer Windows

You canhave an unlimited numberof individual File Transferwindows openat the sametime. However,
only oneof themcanbeusedfor file transferatatime.

5.3 Folder View

The directory structureof the remotehost computeris visible on the left hand paneof the File Transfer
window. The directory structureis presenteds a tree-like folder structure,familiar from the Windows
Explorer.

Foldersthathave a plussign (+) next to themcanbe openedyy clicking on the plussign. Openfoldershave
aminussign(-) next to themandcanbe closedby clicking onthe minussign.

You canclick on afolderto view its contentson theright handside paneof the File Transferwindow. The
displayedolder shavs up highlightedon thefolder view.

Openingor closinga folderin thefolder view doesnot affect thefile view on theright handside,unlessyou
closethedisplayedolder’'s parentfolder. In thatcasethe closedfolder becomeshenew displayedolder.

5.3.1 Folder Colors

To malke file transferoperationseasier the foldersin the remotehostcomputerare displayedin different
colorsaccordingo their status.

Yellow folders are’f amiliar folders’ thatareknown to be availablefor your use.Usuallythis meanghatyou
have openedhemearliet
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Gray folders are 'unknown folders’ that have not yet beenvisited. Thereforethe SSH SecureShell for
WorkstationsVindows client doesnotyetknow if theremotehostcomputerallows youto accesgshem.

Red folders are'forbiddenfolders’. You don't have a permissiorto accesshem,andthereforethe remote
hostcomputerdoesnot allow youto view their contentsIf you selectaredfolder, theFile view ontheright
will beblank. Selectsomeotherfolderto continue.

Green folders are’folders beingloaded’.Whenyou selecta new folder, it turnsgreenfor thetime it takesto
list its contentsUnlessthefolder containsa large numberof files andsubfoldergor the connectioris slow),
thefolder doesnot staygreenlongerthanafractionof asecond.

5.4 File View

Thefiles in the currentlyopenfolder aredisplayedon the File View paneon theright handside of the File
Transferwindow. If you have not yet openedary folders, the initial view shows the files in your 'home
directory’ ontheremotehostcomputer.

You canopenfoldersvisible in theFile View paneby clicking themthe sameway asin the Folderview.

You canmovein thedirectorytreealsoby clicking the ParentDirectorybuttonin thetoolbar, or by pressing
the Backspacdey onthekeyboard.This movestheview from the currentdirectoryto its parentdirectory

Thefile iconsandfile type descriptionsare derived from the client computer If you have a specificicon
associateavith a certainfile type, thefiles in the hostcomputershav up with the familiaricon. This makes
it fasterandeasierfor you to recognizdiles of differenttype.

You canusethe Tabkey to switchbetweerthefolder view andthefile view.

5.5 File Transfer Title Bar

Thetitle baris locatedon thetop of thewindow.

Theleftmostitem onthetitle baris thewindow icon. Click it to displaythewindow menuor doubleclickto
closethewindow.

The next item on the title baris the window’s sequencenumber. This helpsyou to distinguishbetween
differentwindows usingthe sameconnection.

Next onthetitle baris displayedheremotecomputershostname.For example asecondvindow associated
with a connectiorto a hostcomputercalledremotewould displayas2:remote

After the hostname the next item on thetitle baris the nameof the settingfile in use.If you arenotusing
a settingsfile thathasbeensaved with a specificfile name(usingthe Save As option on the File menu),a
settingdile calleddefault isin use.
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Thelasttext item onthetitle baris thenameof theclient, SSHSecureShell File Transfer

5.6 File Transfer StatusBar

Thestatusbaris locatedatthebottomof theFile Transfeiwindow. Whenbrowsingthroughthemenuoptions
or toolbarbuttons,the statushardisplaysa shortcontext sensitve helptext.

Figure5.2: TheFile Transferstatusbardisplayingthe sizeof a selectedile.

Whenthe menusor toolbarsarenot browsed,the left sideof the statusbar displaysthe currentremotehost
computerandthe pathin theremotehost.

Thenext statusharfield shavs the currentprotocolversion,encryptionalgorithm,andMA C algorithmsepa-
ratedby dashegfor example:SSH2 - 3des-cbc - hmac-md5). Notethatthestatusbardisplayssome
of thealgorithmnamesdn alongerform thanthe Connectiorscreerof the Settingdialog.

Therightmostfield of the File Transferstatusbar displaysthe numberof files andsubfoldersn the current
folder, aswell asthetotal sizeof thefiles. If you selecffile(s)in thefolderview, thefield changego display
the numberandtotal file sizeof the currentselection.This is especiallyusefulwhenestimatingthe amount
of total datato betransferred.

5.7 File Transfer Shortcut Menu

Click the File Transferwindow with the right mousebuttonto displaya shortcutmenu. The availablemenu
optionsdependbn whetheryou have selectedafile or not.

Thefollowing menuoptionsareavailablewhenyou have not selectedafile:

Paste

Pastea file from the File Transferclipboard'.

Upload
Transferafile from thelocal computerinto theremotehostcomputer
Up
Move the File Transferwindow focusinto the parentdirectoryof the currentdirectory

Home

Move the File Transferwindow focusinto your homedirectory
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Go to Folder

Openghe Goto Folderdialogwhereyou cantypein a pathof thefolder which youwantto open.

Refresh

Redrav theFile Transferwindow.

SelectAll

Selectall files andfoldersin the currentfolder.

View

Opensa submenurom which you canselectthe view type (large icons, small icons, list or details
view).

Arrange Icons

Opensa submendrom whichyou canselecthow theiconsarearrangedby name by type,by sizeor
by date).

New Folder

Createsa new folder andpromptsyou to entera namefor it. If you enternothing,the folder will not
becreated.

Thefollowing menuoptionsareavailablewhenyou have selectedafile:

Copy

Copy thecurrentlyselectedile into the File Transferclipboard'.

Download

Transferthe currentlyselectedile into thelocal computer

Delete

Remawethecurrentlyselectedile.

Edit Profiles

Edit the profilesassociateavith remotehostcomputers.

Rename

Changehe nameof the currentlyselectedile.

Properties

Displaytheattributesof thecurrentlyselectedile, includingthefile permissiongon UNIX systems).

Theavailableoptionscanbe configuredusingthe Customizedialog (seesection2.6 ( Customize)).
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5.8 Differences~rom Windows Explorer

TheFile Transfewindow operatesery muchthesameway asthefamiliarWindows Explorer.However, due
to thedifferentnatureof handlingfileslocally in yourown computerasperWindows Explorer)andhandling
them over a securedremoteconnectionin the hostcomputer(as per SSH SecureShell for Workstations
Windows clientFile Transfer) therearesomedifferencesn operation.

Deletingfolders
It is not possibleto deletearemotefolderthatis notempty Deletethefiles andsubfoldergesidingin
thefolderfirst.

Multiple pasteoperations

During copy andpasteoperationsthefile namesarenot changedvhenthefiles arepasted.Therefore
it is not possibleto pastefiles severaltimesinto onelocation,creating'copiesof’ the pastediles asin
Windows Exploret

5.9 Downloading Files

By usingtheFile Transferwindow it is easyto downloadfiles from theremotehostcomputerinto yourlocal
computer Thereareseveraldifferentwaysto downloadafile - or severalfiles atthe sametime.

To selectmultiplefiles, hold down the Shift or Controlkeys whenselectindfiles with themouse.f you hold
down the Shift key, all thefiles andfoldersbetweerthe first andlast selectiorwill be selected.If you hold
down the Controlkey, you canselectindividual files andfoldersoneby one.

Drag and drop

Dragginganddroppingis probablythe easiestvay to downloadfiles. Simply click on the file(s) you
wantto download,hold down the mousebuttonandmove thefile to alocationwhereyou wantit - for
exampleon theWindows desktop- andreleasehe button.

Download button

You canclick the Downloadbuttonon thetoolbarto downloadthe selectedile(s).

Shortcut menu

Whenyou click afile or folder usingthe right mousebutton, a shortcutmenuappears.The shortcut
menushons the mostcommonfile operations:open,copy, download,renameanddelete. Selectthe
desiredoperationfrom themenu,andit will beappliedto all of thecurrentlyselectediles or folders.

Whenthe downloadstarts,a Download- SelectFolder dialogwill appearallowing you to selectwherethe
downloadedfile(s) shouldbe sared. After you have selectedhe appropriatefolder (or otherlocation),you
will seea Downloadingdialogthatshavs the currentdownloadingstatus.
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5.9.1 Download - SelectFolder Dialog

Whenyou starta downloadoperationa Download- SelectFolderwindow is displayed.Thisis a standard
Windows file selectiondialog, whereyou canselectthe locationwhereyou want the selectedile(s) to be
downloaded.

You canusethelLook in selectiorbox to selecta folder,alocal or network drive or your desktop.

Anotherway to selecthedesiredfolderis to typeits directorypathin the Folderfield. Notethatyou canuse
this field only to specifythe folder name.Do not write in afile nameafterthe selectedlirectorypath. The
file namewill bethe samethefile hasin theremotehostcomputer.

Figure5.3: Creatinga new directoryfor downloadediles.

The mostcommonoperationanbe achieved by clicking on the four buttonson the right handside of the
Look in selectionbox. You canclick onthe Up OneLevel buttonto move to the parentfolder of the current
folder. If youwantto createanew folder, click onthe CreateNew Folderbutton. You canalsoselecthetween
the SmalllconsandDetailsviews by clicking onthe appropriateéouttons.

5.9.2 The Downloading Dialog

The Downloadingdialogdisplaysthe currentstatusof download.

At thetop of thedialogafamiliarfile copy animationindicatesatransferin progressTheprogresdarbelov
thefile copy animationshows the approximatgercentagef how muchof the currentfile transferhasbeen
completed.

A more exact figure is displayedon the Transferredfield below the progressbar The Transferredfield
displayshow muchof thefile hascurrentlybeentransferrecandwhatis thetotalfile size.

The TransferRatefield shows the currentrateof transfer(how mary kilobytesof dataarebeingtransferred
persecond).

The messagarea,locatedbelown the Transferrecand TransferRatefields, displaysthe transferrediles and
their sizes.Also ary informationalor errormessagearedisplayedhere.
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Whenthe downloadis complete the title of the Downloadingwindow changesnto Download Complete.
Click the Closebuttonto closethe dialogandreturnto the File Transferwindow.

Figure5.4: Thedownloadhasbeencompleted.

5.10 Uploading Files

TheFile Transfewindow canbeusedto uploadfiles from your local computetto theremotehostcomputer.
Therearesereraldifferentwaysto uploadafile.

It is alsopossibleto uploadseveralfiles at the sametime. To selectmultiple files, hold down the Shift or
Controlkeyswhenselectindfileswith themouse If you hold down the Shift key, all thefiles andfoldersbe-
tweenthefirst andlastselectionwill beselectedIf you hold down the Controlkey, you canselectindividual
filesandfoldersoneby one.

Drag and drop

Dragginganddroppingis probablytheeasiestvay to uploadfiles. Simply click onthelocalfile(s)you
wantto upload(for exampleon the desktopor the Windows Explorer),hold down the mousebutton,
move thefile(s)into the File Transferwindow’sfile view andreleasghe button.

Upload button

You canclick the Uploadbuttonon the File Transferwindow’s toolbarto uploadthe selectedile(s).

Shortcut menu

Whenyouclick onanemptyspaceén the File Transfewindow’sfile view usingtheright mousebutton,
ashortcutmenuappearsThe shortcutmenuallows severalfile transferoperationsPaste Upload,Up,

Home, Go To Folder, Refresh,SelectAll, View, ArrangelconsandNew Folder. Selectthe desired
operationfrom themenu.

Whenthe uploadstarts,a Upload - SelectFiles dialog will appeay allowing you to selectthe file(s) that
shouldbe uploaded.After you have selectedhefile(s), click the Uploadbutton. You will seea Uploading
dialogthatshavsthe currentuploadingstatus.
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5.10.1 Upload - SelectFiles Dialog

Whenyou startanuploadoperationa Upload- Selectileswindow is displayed.Thisis astandardVindow
file selectiondialog,whereyou canselectwhich file(s) you wantto upload.

YoucanusethelLook in selectiorboxto selectthelocationof thefile(s): afolder, alocal or network drive or
your desktop.

Figure5.5: Selectthefile youwantto upload.

NotethattheFile namefield displayedat the bottomof the dialogdisplaystheselectedile name.Thefield is
read-only- you cannottypein thedesiredile name.Selectthefiles by clicking themwith themousenstead.

The mostcommonoperationscanbe achieved by clicking on the four buttonson the right handside of the
Look in selectionbox. You canclick onthe Up OneLevel buttonto move to the parentfolder of the current
folder. If youwantto createa new folder, click onthe CreateNew Folderbutton. You canalsoselecthetween
the SmalllconsandDetailsviews by clicking onthe appropriateébuttons.

5.10.2 The Uploading Dialog

The Uploadingdialogdisplaysthe currentuploadingstatus.

At thetop of thedialogafamiliarfile copy animationindicatesatransferin progressThe progresdarbelov
thefile copy animationshows the approximatgercentagef how muchof the currentfile transferhasbeen
completed.

A more exact figure is displayedon the Transferredfield below the progressbar The Transferredfield
displayshow muchof thefile hascurrentlybeentransferrecandwhatis thetotalfile size.

The TransferRatefield shaws the currentrate of transfer(how mary kilobytesof dataarebeingtransferred
persecond).

The messagarea,locatedbelown the Transferrecand TransferRatefields, displaysthe transferrediles and
their sizes.Also ary informationalor errormessagearedisplayedhere.
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Whenthe uploadis complete thetitle of the Uploadingwindow changesnto Upload Complete.Click the
Closebuttonto closethedialogandreturnto the File Transferwindow.

Figure5.6: A file hasbeenuploaded.

5.11 File Properties

Selectingafile in the File View window thenselectingthe Operation Propertiesnenuoptionbringsup the
File Propertiepagewhich allowsyouto view andchangesomeof theremotefiles properties The Properties
pagecanalsobeaccessedy right clicking on afile in the File View paneandselectingProperties.

Figure5.7: Propertiegpagefor afile.
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File Name
At thetop of the pagethefile nameandicon areshavn. If multiple files areselecteda countof the
numberof files andfoldersis displayed.
Type
Thetype of the selectedile(s).
Location
Thedirectorywherethe selectedile(s) arelocatedon theremotehost.
Size
Thesizeof theselectedile. If multiplefiles areselectedhetotal sizeof all thefilesis diplayed.
Modified Date

Thelastmodifieddatefor the selectedile.

Permissions

The 9 checkboxscanbe usedto setthe permission®f a file or a groupof files. If multiple files are
selectedvith conflictingpermissionshensomeof thecheckboxswill appeagrayedout. Clicking on
agreyedout checkboxwill clearthecheckmarklIf thereareary checkboxsaregrayedoutwhenthe
OK buttonis pressedt will have the effect of leaving thatvalueunchangean theremotefile.

Permissionganalsobe setby enteringstandardctal Unix permissiormasksin the PermissiorMask
editbox.Valuesenterechereoverrideandupdatethe checkboxvalues.
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Chapter 6

Toolbar Reference

The mostimportantfunctionsof the SSHSecureShellfor WorkstationsWindows client’s terminalwindow
andFile Transferwindow canbe accessedsingthe toolbar. Thetoolbaris locatedat the top of the SSH2
clientwindow, right underthemenubar

Figure6.1: Thebasictoolbarcontainsbuttonsfor the mostfrequentlyusedfunctions.

The profilestoolbaris locatedunderthe basictoolbar containingthe Quick ConnectandProfilesoptions.

Figure6.2: The profilestoolbarcontainghe Quick ConnectandProfilesbuttons.

6.1 Configuring Toolbars

The SSH SecureShell for WorkstationsWindows client hasa dynamicuserinterfacethatis very easyto
modify to matchto yourtastes.You canselectthe positionof thetoolbars andevenmove individual buttons
from oneplaceto another

6.1.1 Moving Toolbars

You canusethe mouseto grabthetoolbarsby their handleglocatedon the lefthandendof eachtoolbar)and
move themaroundthe SSHSecureShellwindow.
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You canhavethetoolbarsfloatingfreely in thewindow, or anchorthemin thetop, bottomor eveneitherside
of thewindow. Experimento find thetoolbarpositionsthatyoulike best.

6.1.2 Moving Toolbar Buttons

You canalsomove individual toolbarbuttonsaroundandarrangehemsothatthey bestsene your needs.

To move a toolbar button, keepthe Alt  key on the keyboardpresseddown and grab a button with your
mouse. You will seea nev mousepointerappear Click the buttonwith your left mousebutton, keepthe
mousebutton pressedlown and move the button around. Whenyou releasehe mousebutton, the toolbar
buttonwill bemove to a new position.

Note: If you move abuttonto somevhereelsethanatoolbar(for example,in theterminalwindow text area),
it is removedfrom the window. But don't worry - the changedecomepermanenbnly if you usethe Save
Settingsoption(seesection6.2 (Sare Settings)).

6.1.3 PermanentToolbar Changes

If youwantto make the new toolbarpositionspermanentysethe Sare Settingsoption (from the toolbaror
theFile menu)to save your settings.

If youchangeyour mind andwantto returnthetoolbarsto their original positions selectthe Resefloolbars
optionfrom theView menu.A confirmationdialogwill open,askingif youreallywantto discardthechanges
you have made. If you selectYes,thetoolbarswill returnto their original configuration.If have modified

your menusthis optionwill resetalsothem.

6.2 Save Settings
Selectthe Save Settingsoption to save ary changes/ou have madeto your currentsettings. The default
settingdfile wherethe configuratiorwill besavedis default.ssh2

If youwantto save your currentsettingsn anew settingile, selectheAdd ProfileoptionundertheProfiles
option(seesection3.2 (Profiles)).

6.3 Print

Selectthe Print optionto outputthe contentsof the currentscrollbackbuffer to your printer. The standard
Windows Printdialogwill appearallowing youto selecttheprintersettings.

The print rangecan also be selectedfrom this dialog. SelectingAll will print the entire contentsof the
terminalscrollbackbuffer. If the whole scrollbackbuffer will fill morethanonepagewhenprinted,arange
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Figure6.3: ThePrintdialogallows youto specifythe printersettings.

of pagedo print canbeselectedIf ary text is selectedvhenyou usethe Print option,the default print range
will be Selectionwhichwill only print the currentlyselectedext.

You canusethe Print Preview option (seesection6.4 (Print Preview)) to helpyouto determinewhich pages
to printandhow the printoutwill look like.

Note: whenyou useanetwork printer,theareaselectedor printingwill besentunencrypteaverthenetwork
to theprinter.

ThePrintoptionis availableonly in theterminalwindow.

6.4 Print Preview

SelecthePrint Preview optionto displaythe entirecontentf theterminalscrollbackbuffer, splitinto pages
in the sameway asthe scrollbackbuffer will appeamhenprinted.

Figure6.4: The Print Preview optionshaw the scrollbackbuffer asit would appeamwhenprinted.
Thefollowing buttonscanbe usedto preview the print result:

Print

ThePrintbuttonopenghe Printdialog,allowing youto specifytheprintersettingsandprint theresult.

Next Page
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Click the Next Pagebuttonto preview the next pageof output.

Prev Page
Click the Prev Pagebuttonto preview the previous pageof output.

Two Page

Click theTwo Pagebuttonto displaytwo pagesf outputsideby side. Whenin two pageprint preview
mode the Two pagebuttonis replacedy OnePagebutton,which allows youto returnto theonepage
print preview mode.This button cannotbe usedwhenyou have zoomedhepage.

Zoomln

Click the ZoomIn buttonto seea closeupof the currentlydisplayedprint preview page.You canuse
this buttonto zoomup to the naturalsize of the printout. You canzoomin alsoby clicking the left
mousebuttonon the preview view.

Zoom Out

Click the Zoom Out buttonto returnfrom a zoomedn view of the print preview page.You canzoom
outuntil thewholepageis displayed.

Close
Click the Closebuttonto closethe Print Preview dialog.

ThePrint Preview optionis availableonly in theterminalwindow.

6.5 Connect

SelectheConnecbptionto connecto aremotehostcomputer A Connecto RemoteHostdialogwill open.

Figure6.5: The Connectto RemoteHostdialog.

For moreinformationon this dialog, seesection3.4.2(Connectiorto RemoteHostDialog).

6.6 Disconnect

Selectthe Disconnectoption to quit the currentconnection. A Confirm Disconnectdialog is displayed,
allowing you to confirmif you really wantto disconnectSelectNo or Cancelto keepthe connectioropen,
or Yesto endthe connection.
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Figure6.6: The ConfirmDisconnectialoggivesyou thelastchangeoptionof changingyour mind.

Note that one connectioncan have several windows open(suchasan SSH SecureShell for Workstations
Windows clientterminalwindow andaFile Transferwindow). Disconnectingaffectsall windows associated
with a singleconnection.

However, if youhave startebther separat&SHSecureShellfor WorkstationaNindows clients,they arenot
affectedby this disconnecbperation.Disconnectingjuitsoneconnectiorandall of its associateavindows,
but no other separateonnections.

6.7 Copy

Selectthe Copy optionto createatemporarycopy of theselectedext or files.

If you arecopying text (in the terminalwindow), the text is placedon the Windows clipboardand canbe
pastedn theterminalwindow or ary Windows text window.

If youarecopying files (in the File Transferwindow), a Downloaddialogis displayedbut the selectediles
arenotyet copiedto ary specificlocation. This resemblesisingthe Windows clipboard: You cancopy files
to atemporarystorageandpastethemlaterinto anotheldocation.

If youdoanew copy operationwhenthe previously copiedtext or files have not yet beencopiedanywhere,
thepreviousselectionis lost, asthe new selectiorreplacegheold one.

Notethatthe copy optionis notavailableuntil you have selectedsometext (in theterminalwindow) or one
or severalfiles or folders(in the File Transferwindow).

You cando a copy operationalso by usingthe keyboardshortcutCtrl+Insert. This shortcutis availablein
both TerminalandFile Transferwindows.

6.8 Paste

Selectthe Pasteoptionto addpreviously copiedtext or files or foldersinto a new location.

If you arepastingtext (in the terminalwindow), the text that was copiedearlierinto the clipboardwill be
insertedin the cursorlocation. You canpastetext that was copiedfrom the terminalwindow or ary other
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Windows text window.

If you arepastindfiles (in the File Transferwindow), anUploaddialogis displayedwvhenthefiles arepasted
to thenew location. Thisresemblesisingthe Windows clipboard: You cancopy filesto atemporarystorage
andpastethemlaterinto anothelocation. Thefile namef the pastediles andfoldersdo not changeduring

theoperation.Thereforet is not possibleto pastefiles or folderssereraltimesinto onelocation.

Notethatthe pasteoperatioris not availableuntil you have previously copiedsomethingn theclipboard.

You cando a pasteoperatioralsoby usingthe keyboardshortcutShift-Inserton the keyboard. This shortcut
is availablein both TerminalandFile Transferwindows.

6.9 PasteSelection

Selectthe PasteSelectionoptionto pastetext into theterminalwindow without first copying anythingto the
clipboard.The PasteSelectionoperationcopieswhateveris currentlyselectedn theterminalwindow to the
presentursorposition. If notext is selectedPasteSelectionpasteghe singlecharactein the currentcursor
position.

This functionis almostlike having two differentclipboardsavailable at the sametime. PasteSelectionis
especiallyusefulfor quick copying of text from the outputof previouscommands.

The PasteSelectiortoolbarbuttonis availableonly in theterminalwindow.

6.10 Find

SelecttheFind optionto locatetext (or any othercharactersjrom thescrollbackbuffer. Regularexpressions
canbeusedto selectcharactersnatchinga specificpattern.

Figure6.7: TheFind dialoghelpsyouto locatetext from the scrollbackbuffer.

Find what

Typein the charactershat you wantto searchfor in the Find whatfield. If you wantto useregular
expressiongo definethe searchterm, selectthe Regular expressionoption, or selecta readydefined
regularexpressiorby clicking theellipsisbutton(...) ontheright handsideof the Find whatfield.
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Click theellipsishutton(...) to selectfrom areadylist regularexpressionsUsingthis optionwill turn
onthe Regularexpressioroption.

Thefollowing regularexpressiortypescanbe selected:

Any Character
Character in Range
Character not in Range
Beginning of Line

End of Line

Or

0 or Mor e Matches

1 or Mor e Matches
Optional Match

Match exactly n times
Match n or moretimes
Match at mostn times

Match no lessthan n times

Match whole word only
Selectthe Match wholeword only optionto limit the searchto matchonly whole words(i.e. sothat
"wave” would not match"waves”).

Match case
Selectthe Match caseoption to specify that the searchresult shouldbe casesensitve (i.e. so that
"Wave” would notmatch"wave” or "wa\e”).

Regular expression

Selectthe Regularexpressioroptionto specifythe searchhtermusingregularexpressionsThis option
is automaticallyselectedf you click the ellipsis button(...) on theright handside of the Find what
field.

Dir ection

Usethe Direction optionto specifywhetherthe searchshouldstartupwardson downwardsfrom the
presenpositionin the scrollbackbuffer.

Thedirectionof the searchs relative to the last matchmadein the currentsearch.If therehave been
no previous matchesUp will searchfrom the bottom of the buffer upwards,and Down will search
downwardsfrom thevery beginningof the buffer.

Up
The Up optionspecifieghatthe searctshouldstartbackwardsfrom the presenposition.
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Down
The Down optionspecifieghatthe searchshouldstartforwardfrom the presenposition.

Find Next

Click the Find Next buttonto find the next matchfor thesearchterm. Notethatthedirectionwherethe
searchwill continueis definedby the Directionoption.

Cancel

Click the Cancelbuttonto closethe Find dialog.

6.11 NewTerminal Window

Selectthe New TerminalWindow optionto opena new SSHSecureShellfor WorkstationsWindows client
terminalwindow. Thenew window isimmediatelyconnectedo thesamaemotehostcomputerlasthecurrent
window, saving you thetroubleof typing your passverd again.

Multiple windows to a singleconnectiorallow you to for exampledehug your codein onewindow, execute
it in anotherdisplayreferencanformationin athird oneandreadyour mail in a fourthwindow.

The sequencenumberof eachwindow is displayedon the window’s title bar, in front of the remotehost
computers name. For example,a secondwindow associatedvith a connectiorto a hostcomputercalled
remotewould displayas2:remote

Note: To closeary extrawindowswhenyou no longerneedthem,click onthe X-shapedtlosebuttonlocated
on the window’s title bar on the upperright handcornerof the window. Do not click on the Disconnect
buttonor selectthe Disconnecbptionfrom the File menu,asthis would closethe connectiorin all windows

associateavith this particularconnection.

6.12 NewFile Transfer Window

Selectthe New File TransferWindow optionto opena File Transferwindow. To make file handlingaseasy
aspossibleyou canopenanunlimitednumberof File Transferwindows.

The sequencenumberof eachwindow is displayedon the window’s title bar, in front of the remotehost
computers name. For example, a third window associatedvith a connectionto a host computercalled
remotewould displayas3:remote

Note: To closeary extrawindowswhenyou no longerneedthem,click onthe X-shapedtlosebuttonlocated
on the window’s title bar on the upperright handcornerof the window. Do not click on the Disconnect
buttonor selectthe Disconnecbptionfrom the File menu,asthis would closethe connectiorin all windows

associateavith this particularconnection.
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6.13 Settings

Selectthe Settingsoption to bring up the Settingsdialog. Settingscanbe usedto control both the global
settingsand the profile settingsfor eachparticularremotehost computer. For more information on the
Settinggdialog,seechapter?2 (Configuration).

6.14 Help

Selectthe Help optionto openthe SSHSecureShellWindows client helpwindow. In the helpwindow you
canbrowse,searchandprint helpinformation.

6.15 GetHelp On

Selectthe GetHelp On optionto changethe mousepointerto a help pointer. You canusethe help pointer
to click on buttons,menuitemsor otherdetailsof the userinterfaceto seecontet sensitve help on ary
particularitem.

6.16 File Transfer SpecificToolbar Buttons

Thefollowing toolbarbuttonsareavailableonly in the File Transferwindow.

Figure6.8: The buttonsthatareavailableonly in the File Transferwindow arelocatedbetweerthe Settings
buttonandthe Help button.

6.16.1 Up

Selectthe Up optionto move theview from the currentfolderto its parentfolder.

For example: You have a directorycalledhome andit hasa subdirectorycalledmail . If you arecurrently
viewing themail folderandclick the Up button,thefocusmovesto thehome folder.

6.16.2 Home

Selectthe Homeoptionto returnto your homedirectoryon the remotehostcomputer.This is usefulif you
areexploringacomplec directorytreeandwantto quickly returnto whereyou camefrom.
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6.16.3 Refresh

SelectheRefreshoptionto redrav the File Transfeiwindow. Thismaybenecessarif you have for example
uploadedfile thatdoesnotimmediatelybecomevisible onthe remotehostcomputer.

6.16.4 Download

Selectthe Downloadoptionto downloadafile - i.e. to copy it from the remotehostcomputerto your local
computer.

6.16.5 Upload

SelectheUploadoptionto uploadafile - i.e. to copy it from yourlocalcomputeto theremotehostcomputer.

6.16.6 Largelcons

Selectthe Largelconsoptionto displaythefile view asa Large Iconsview. Eachfile andfolder hasa large
icon associatedvith it, makingfor a clearanduncluttereddisplay

6.16.7 Smalllcons

Selectthe Smalllconsoptionto displaythefile view asa Smalllconsview. Eachfile andfolder hasa small
iconassociatedvith it. This makesit possibleto displayseveraltimesmoreitemsthanthe Largelconsview.

6.16.8 List

Selectthe List optionto displaythefile view asa List view. Eachfile andfolder hasa smallicon associated
with it, andthefiles andfoldersaredisplayedn onesinglecolumnunderneatteachother

6.16.9 Details

Selectthe Detailsoptionto displaythefile view asa Detailsview. Thefiles andfoldersaredisplayedwith a
smallicon, theirfile name file size,file type,lastmodificationdateandattributesvisible.

By clicking onthe Name,Size, TypeandModified sortbarslocatedon top of the File view, you cansortthe
files andfoldersbasedon their file name file size,file type andthetime they werelastmodified. Selecting
thesamesortoptionagainreverseshe sortingorder.
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Notethatthe sortfunctionis not casesensitve: uppercasetext is sortedtogethemwith lower casetext.

Thefile typesarederived from the your local computer If you have defineda new file type descriptionfor
fileswith a certainfile nameextension alsothefilesin theremotecomputerareshovn to be of thatfile type.
This malkesit easyto recognizeparticularfile typesalsoon theremotecomputer

6.17 Quick ConnectButton

Click the Quick Connectbutton on the profilestoolbarto opena new connectiorusingthe default settings.
For moreinformation,seesection3.1 ( Quick Connect).

6.18 ProfilesButton

Click the Profilesbutton on the profilestoolbarto openthe Profilesmenu. For moreinformationon how to
useprofiles,seesection3.2 (Profiles).
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Chapter 7

Menu Reference

Togetherwith thetoolbar, the terminalwindow menusallow quick accesgo differentterminaloperations.
Thefollowing menusareavailable: File, Edit, View, Operation(only in the File Transferwindow), Window
andHelp.

7.1 Configuring Menus

The SSHSecureShellmenuscanbe configuredaseasilyasthetoolbars. You canfreely selectthe position
of themenusandevenmove theminto toolbars.

7.1.1 Moving Menus

You canmove the SSHSecureShellmenusinto new positionsandarrangeghemsothatthey bestsene your
needs.

To move amenu,keepthe Alt  key onthekeyboardpressediown andclick a menuwith your mouse.You
will seeanew mousepointerappearKeepthemousebuttonpressediown andmove themenuaround.When
you releasehe mousebutton,the menuwill be moveto a new position.

Thisway you canarrangehe orderof the menusor evenmaove menusinto toolbars.Experimento find the
bestconfiguratiorfor you.

It alsopossibleto move the individual menuoptions. This canbe doneusingthe Commandgageof the
Customizealialog(seesection2.6 ( Customize)).

Note: If you move a menuto someavhereelsethanthe menubaror a toolbar(for example,in the terminal
window text area),it is removedfrom thewindow. But don't worry - thechangedbecomepermanenonly if
you usethe Sare Settingsoption (seesection6.2 (Save Settings)).
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7.1.2 PermanentMenu Changes

If youwantto make the new menupositionspermanentsethe Save Settingsoption (from thetoolbaror the
File menu)to save your settings.

If you changeyour mind andwantto returnthe menusto their original positions,selectthe ResetToolbars
optionfrom the View menu.A confirmationdialogwill open,askingif youreallywantto discardthechanges
you have made.If you selectYes,themenuswill returnto their original configuration.If have modifiedalso

yourtoolbars this optionwill resetthem,too.

7.2 File Menu

TheFile menuallows accesgo the settinggfile andconnect/disconnecdperations.

7.2.1 Save Settings

Selectthe Save Settingsoption to save ary changes/ou have madeto your currentsettings. The default
settingdfile wherethe configuratiorwill besavedis default.ssh2

If youwantto save your currentsettingsn anew settingile, selectheAdd ProfileoptionundertheProfiles
option(seesection3.2 (Profiles)).

7.2.2 Quick Connect

SelectheQuick Connectmenuoptionfrom the File menuto openanew connectiorusingthedefaultsettings.
For moreinformation,seesection3.1 ( Quick Connect).

7.2.3 Profiles

Selectthe Profilesmenuoptionfrom the File menuto openthe Profilesmenu.For moreinformationon how
to useprofiles,seesection3.2 (Profiles).

7.2.4 Print

The Print menuoptionwill allow you outputthe contentsof the currentscrollbackbuffer to a printer For
moreinformationon printing, seesection6.3 (Print).

ThePrintoptionis availableonly in theterminalwindow.
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7.2.5 Print Preview

SelectingPrint Preview will displaythe entire contentsof the scrollbackbuffer split into pagesn the same
way it will beprinted.For moreinformationon previewing theprinteroutput,seesection6.4 (Print Preview).

ThePrint Preview optionis availableonly in theterminalwindow.

7.2.6 PageSetup

The PageSetupmenuoptionallows you to specifyhow printedpageswill look. For moreinformation,see
section2.5.9(Printing).

The PageSetupmenuoptionis availableonly in the terminalwindow.

7.2.7 Log Session

ChoosehelLog Sessioroptionto save anentiretranscriptof the currentterminalsessiorto afile.

WhenLog Sessioris selectedthe Save As dialogopens askingfor afilenamefor thelog file. Thisfile will
be createdf it doesnot alreadyexist, andit will containa transcriptof the connection.Selectingthe Log
Sessiormenuitem for a secondime stopslogging.

Whenloggingis active,acheckmarkappearsext to the Log Sessiormenuoption.

TheLog Sessiormenuoptionis availableonly in theterminalwindow.

7.2.8 Connect

SelectheConnecbptionto establisranew SSHconnectiorio aremotehostcomputer A Connecto Remote
Hostdialogwill appearallowing you to specifythe hostname(or IP address)usernameandpassverd for
thenew connection.

An alternatve wayto establistanew connectionis to presghe Enterkey onthekeyboardwhendisconnected.
Thiskeyboardshortcuthasthe sameeffectaschoosinghe Connecboptionfrom the File menuor thetoolbar

Notethatthe Connectoptionis availableonly whenyou arenot connectedo ary remotehostcomputer.If
youwantto establisha completelynew, separat&SHconnectionselecthe New Connectioroptioninstead.

7.2.9 Disconnect

Selectthe Disconnecioptionto disconnecfrom the presentemotehostcomputer.A Confirm Disconnect
dialog appearsallowing you to confirmif you really wantto disconnect.SelectNo or Cancelto keepthe
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connectioropen,or Yesto endthe connection.

Notethatoneconnectiorcanhave severalwindowsopen(suchasan SSHSecureShellfor Workstationain-
dows client terminalwindow andthe File Transferwindow). Disconnectingaffectsall windows associated
with a singleconnection.

However, if youhave startedbther separat&SHSecureShellfor WorkstationaVindows clients,they arenot
affectedby this disconnecbperation.Disconnectingjuitsoneconnectiorandall of its associateavindows,
but noneof the separateonnections.

7.2.10 Exit

Selectthe Exit optionto quit the SSHSecureShellfor WorkstationsNindows client. A Confirm Exit dialog
appearsallowing you to confirmif you really wantto exit. SelectNo or Cancelto keepthe SSH2client
running,or Yesto exit.

Note that one connectioncan have several windows open(for exampleseveral File Transferwindows and
severalterminalwindows). Exiting affectsall windows associateavith a singleconnection.

However, if you have startedother separateSsSH SecureShellfor Workstationswindows clients, they are
not affectedby this exit operation.Exiting quits oneconnectiorandall of its associatedvindows, but none
of theseparateonnections.

7.3 Edit Menu

The Edit menuallows you to copy and pastetext in the terminalwindow andto make changego your
connectiorsettings.

7.3.1 Copy

Selectthe Copy optionto createa temporarycopy of the selectedile(s). A Downloaddialogis displayed,
but theselectedilesarenotyetcopiedto ary specificlocation. Thisresemblesisingthe Windows clipboard:
You cancopy filesto atemporarystorageandpastethemlaterinto anothedocation.

If you do a new copy operationwhenthe previously copiedfiles have not yet beencopiedanywhere,the
previousselections lost, asthe new selectiorreplacegheold one.

Notethatthe copy operations not availableuntil you have selectedneor severalfiles or folders.

The keyboardshortcutfor the copy optionis Ctrl+Insert. The shortcuthasthe sameeffect aschoosingthe
Copy optionfrom the Edit menuor toolbat
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7.3.2 Paste

Selectthe Pasteoption to add previously copiedfiles or foldersinto a new location. An Uploaddialogis
displayedwhenthe files are pastedo the new location. This resemblesisingthe Windows clipboard: You
cancopy filesto atemporarystorageandpastehemlaterinto anotheldocation. You cando a pasteoperation
alsoby pressingCtrl+V onthekeyboard.

Thefile namesof the pastediles andfoldersdo not changeduringthe operation.Thereforeit is not possible
to pastéfiles or foldersseveraltimesinto onelocation.

Notethatthe pasteoperationis not availableuntil you have previously copiedsomethingn the SSHSecure
Shellfor WorkstationsNindows client 'clipboard’.

Thekeyboardshortcutfor Pasteis Shift+Insert. Theshortcuthasthe sameeffectaschoosinghe Pasteoption
from the Edit menuor toolbar

7.3.3 PasteSelection

Selectthe PasteSelectionoptionto pastetext withoutfirst copying anything to the clipboard. The PasteSe-
lectionoperationcopieswhateveris currentlyselectedn theterminalwindow to the presentursorposition.
If notext is selectedPasteSelectiorpasteghesinglecharactein the currentcursorposition.

This function is almostlike having two differentclipboardsavailable at the sametime. PasteSelectionis
especiallyusefulfor quick copying of text from the outputof previouscommands.

The PasteSelectiormenuitemis only availablein theterminalwindow.

7.3.4 SelectAll

ChooseheSelectAll optionto selectall thetext in the currentterminalwindow andthe scrollbackbuffer (or
all thefiles andfoldersin the currentremotedirectory whenusingthe File Transferwindow).

Notethatin theterminalwindow, the selectioncanspanquite a few linesbackwardsfrom whatis currently
visible. If youwantto selectjust whatis currentlydisplayedon screenusethe SelectScreenmenuoption
instead.

Whenusedin theterminalwindow, this operatiormalesit fastandeasyfor exampleto saze long command
outputstringsor to createatemporarylog of whatis displayedon the screen.

For file transfer this enablesyou to operateon the whole contentsof a directoryat onetime. This canbe
especiallyusefulwhendownloading,copying or deletingfiles.

The keyboardshortcutfor SelectAll is Ctrl+A. This hasthe sameeffect aschoosingthe SelectAll option
from the Edit menu.
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7.3.5 SelectScreen

Choosethe SelectScreernoptionto selectall thetext thatis currentlyvisible in the terminalwindow. Note
thatunlike the SelectAll menuoption,SelectScreerdoesnot capturethe scrollbackbuffer.

This operationcanbe especiallyusefulfor screercapturesandquick snapshotsf the commandutput.

The SelectScreermenuoptionis availableonly in theterminalwindow.

7.3.6 SelectNone

Choosethe SelectNone option to cancelary previous selection. This operationimmediatelyclearsthe
selectionin theterminalwindow.

The SelectNonemenuoptionis availableonly in theterminalwindow.

7.3.7 Find

ChoosingheFind optionallows youto searckor text within the scrollbackbuffer. For moreinformationon
searchingseesection6.10( Find).

The Find menuoptionis availableonly in theterminalwindow.

7.3.8 Settings

Selectthe Settingsoption to bring up the Settingsdialog. Settingscanbe usedto control both the global
settingsand the profile settingsfor eachparticularremotehost computer. For more information on the
Settinggdialog,seesection2 (Configuration).

7.4 View Menu

The View menuallows you to selectthe way the window is displayed. The terminalwindow andthe File
Transferwindow have their own setof View menuoptions.
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7.4.1 Terminal Window View Menu Options
Toolbar

Selectthe Toolbaroptionto togglethetoolbaron andoff. Whenthetoolbaris visible, a checkmarkappears
next to the Toolbarmenuoption.

StatusBar

Selectthe StatusBar optionto togglethe statusbar on andoff. Whenthe statusbaris visible, a checkmark
appearsext to the StatusBar menuoption.

ProfilesBar

Selectthe ProfilesBar optionto togglethe profilesbaron andoff. Whenthetoolbaris visible, acheckmark
appearsext to the ProfilesBar menuoption.

Customize

Selectthe Customizeoptionto modify the menuoptions,toolbars,menusettingsandgeneralsettings.The
Customizalialogopens For moreinformationon customizingheuserinterface seesectiorn2.6 (Customize).

ResetToolbars

Selectthe Resefloolbarsoptionto resetthetoolbarandmenupositionsto their original state.Thisis agood
choiceif you regretthe changeyou have made or have misplacedsomemenuor toolbaroption.

ResetTerminal

SelectheResefTerminaloptionto resettheterminalsettingso the statethey werein whenconnectingThis
will cleartheterminalwindow andthe scrollbackbuffer andresetthe keymap,characterseandfonts.

7.4.2 File Transfer View Menu Options
Toolbar

Selectthe Toolbaroptionto togglethetoolbaron andoff. Whenthetoolbaris visible, a checkmarkappears
next to the Toolbarmenuoption.
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StatusBar

Selectthe StatusBar optionto togglethe statusbar on andoff. Whenthe statusbaris visible, a checkmark
appearsext to the StatusBar menuoption.

ProfilesBar

Selectthe ProfilesBar optionto togglethe profilesbaron andoff. Whenthetoolbaris visible, acheckmark
appearsext to the ProfilesBar menuoption.

Customize

Selectthe Customizeoptionto modify the menuoptions,toolbars,menusettingsandgeneralsettings.The
Customizadialogopens For moreinformationon customizingheuserinterface seesectiorn2.6 (Customize).

ResetToolbars

Selectthe Resefloolbarsoptionto resetthetoolbarandmenupositionsto their original state.Thisis agood
choiceif youregretthe changeyou have made or have misplacedsomemenuor toolbaroption.

Largelcons

Selectthe Largelconsoptionto displaythefile view asa Large Iconsview. Eachfile andfolder hasa large
icon associatedvith it, resultingin a clearanduncluttereddisplay

If theLargelconsoptionis selecteda selectiormarlker appearsext to the Largelconsmenuoption.

Small Icons

Selectthe Smalllconsoptionto displaythefile view asa Smalllconsview. Eachfile andfolder hasa small
iconassociatedvith it. This makesit possibleto displayseveraltimesmoreitemsthanthe Largelconsview.

If the Smalllconsoptionis selecteda selectiormarker appearsext to the Smalllconsmenuoption.

List

Selectthe List optionto displaythefile view asaList view. Eachfile andfolder hasa smallicon associated
with it, andthefiles andfoldersaredisplayedn onesinglecolumnunderneatteachother

If theList optionis selecteda selectiormarker appearsext to the List menuoption.
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Details

Selectthe Detailsoptionto displaythefile view asa Detailsview. Thefiles andfoldersaredisplayedwith a
smallicon, theirfile namefile size,file type,lastmodificationdateandattributesvisible.

By clicking onthe Name,Size, TypeandModified sortbarslocatedon top of the File view, you cansortthe
files andfoldersbasedon their file name file size,file type andthetime they werelastmodified. Selecting
thesamesortoptionagainreverseshe sortingorder.

Notethatthe sortfunctionis not casesensitve: uppercasetext is sortedtogethemwith lower casetext.
Thefile typesarederived from the your local computer If you have defineda new file type descriptionfor

fileswith a certainfile nameextension alsothefilesin theremotecomputerareshown to be of thatfile type.
This malkesit easyto recognizeparticularfile typesalsoonthehostcomputer

Arrange Icons

Selectthe Arrangelconsoptionto opena submenwhereyou canselectin which orderthefiles andfolders
aredisplayedn thefile view. A selectiormarker appearsext to the currentlyselecteddrrangelconsoption.

By Name: Thefiles andfoldersarearrangedalphabeticalljbasecdbn theirfile name.
By Type: Thefiles andfoldersarearrangedalphabeticallybasedon their file type.
By Sze: Thefilesarearrangedy theirfile size.Foldersarearrangedalphabetically
By Date: Thefiles andfoldersarearrangedy thetime they werelastmodified.

If you have selectedhe Detailsview, you canachieve the sameeffect by clicking onthe Name,Size, Type
andModified sortbarslocatedontop of theFile view. SelectinghesameArrangelconsoptionagainreverses
thesortingorder.

Notethatthe sortfunctionis not casesensitve: uppercasetext is sortedtogethemwith lower casetext.

Show Root Dir ectory

Selectthe Shav Root Directory optionto toggleif the root directoryis displayedin the folder view. If the
root directoryis not displayed,you arenot ableto selector view ary foldersabove your homedirectoryin
thedirectorytreehierarchy By defaulttheroot directoryis notdisplayed.

If the Shov RootDirectory optionis selecteda selectionmarker appearsiext to the Shav Root Directory
menuoption.

SSHSecure ShellWindows Client (© 2000SSHCommunicationSecurityCorp



98 Chapter 7. Menu Reference

Show Hidden Files

Selectthe Shav HiddenFiles optionto toggleif the normally hiddenfiles in the remotehostcomputerare
displayedn thefile view.

By default, UNIX hostsdo not displayary files or directoriesthat begin with thedot (.) charactersuchas
.rhostsor .profile. Selectingthe Shov HiddenFiles optioncorresponds$o specifyingthe-a switchof thels
command.

If the Shav HiddenFilesoptionis selecteda selectionmarker appearsext to the Shov HiddenFilesmenu
option.

Refresh

SelectheRefreshoptionto redrav the File Transfeiwindow. This maybenecessarif you have for example
uploaded file thatdoesnotimmediatelybecomevisible onthe remotehostcomputer.

Thekeyboardshortcutfor Refreshis F5.

7.5 Operation Menu

The Operationmenuallows you to copy files to and from the remotehost computey andto navigatethe
remotedirectorystructure.The Operatiormenuis availableonly in the File Transferwindow.

7.5.1 Open

The Openoption canbe usedto view a file on the remotehostcomputer First selecta file from the File
Transferwindow andthe selectthe Openoption. Thefile will bedownloadedanddisplayed.

7.5.2 Upload

SelectheUploadoptionto uploadafile - i.e. to copy it from yourlocalcomputeto theremotehostcomputer.

The keyboardshortcutfor Uploadis Ctrl+U. This hasthe sameeffect aschoosingthe Up optionfrom the
Operationmenuor thetoolbar

7.5.3 Download

Selectthe Downloadoptionto downloadafile - i.e. to copy it from the remotehostcomputerto your local
computer.

(© 2000SSHCommunicationSecurityCorp SSHSecure ShellWindows Client



7.5. Operation Menu 99

Notethatyou mustfirst selecttheremotefile(s) beforeselectingDownload. If nofiles or foldersareselected,
the Downloadmenuoptionis grayedout.

The keyboardshortcutfor Downloadis Ctrl+D. This hasthe sameeffect aschoosingthe Downloadoption
from the Operatiormenuor thetoolbar

7.5.4 Up

Selectthe Up optionto move theview from the currentfolderto its parentfolder.

For example: You have a directorycalledhome andit hasa subdirectorycalledmail . If you arecurrently
viewing themail folderandclick the Up button,thefocusmovesto thehome folder.

Thekeyboardshortcutfor Up is the Backspacéey. This hasthe sameeffectaschoosingthe Uploadoption
from the Operatiormenuor thetoolbar

7.5.5 Home

Selectthe Homeoptionto returnto your homedirectoryon the remotehostcomputer.Thisis usefulif you
areexploringacomple directorytreeandwantto quickly returnto whereyou camefrom.

The keyboardshortcutfor Homeis Ctrl+H. This hasthe sameeffect aschoosingthe Homeoptionfrom the
Operatiormenuor thetoolbar

7.5.6 Go To Folder

Selectthe Go to Folder optionto entera folder whereyou wantto move directly. A Go to Folder dialog
appearsallowing you to typein the pathto the desireddirectory. The currentdirectorypathis displayedn
thetext field for yourreferencegliminatingtheneedto typein long directorypathsfrom scratch.Typein the
desireddirectorypathandpressEnter . Thespecifieddirectoryinstantlyappears.

If you specifya directorythatdoesnot exist, thefile view turnsblank andthe noneistentdirectoryappears
in thefolderview asaredfolder,meaninghatsuchafolderis notaccessibléo you. Thesef alsedirectories’
cansene asusefulremindershatyou have tried to accesglirectorieswith suchnamesput remembethat
they maynot actuallyexist on theremotehostcomputer.

The keyboardshortcutfor Go To Folderis Ctrl+F. This hasthe sameeffect as choosingthe Go to Folder
optionfrom the Operatiormenu.
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7.5.7 NewFolder

Selectthe New Folderoptionto createa new folder on the remotehostcomputer.A new folder appearon
file view alongwith atext field whereyou cantypein the namefor the new folder.

If youdo nottypeanamefor the new folder but just hit Enter , anew folderis notcreated.

Thekeyboardshortcutfor New Folderis Ctrl+N. This hasthe sameeffectaschoosinghe New Folderoption
from the Operationmenu.

7.5.8 Delete

Selectthe Deleteoptionto deletefile(s) or folder(s)on the remotehostcomputer.A Confirm Deletedialog
appearsallowing youto confirmif youreallywantto deletethe selectediles or folders.SelectNo or Cancel
to keepthe selectedtems,or Yesto deletethem.

The keyboardshortcutfor Deleteis the Deletekey. This hasthe sameeffect aschoosingthe Deleteoption
from the Operationmenu.

7.5.9 Rename

Selecffirst afile from the File Transfewindow andthenthe Renameoptionto renamethefile.

The keyboardshortcutfor renames F2. This hasthe sameeffect aschoosingthe Renameoptionfrom the
Operationmenu.

You canalsorenameafile by clicking on thefile with theright mousebutton. A shortcutmenucontaining
theRenameoptionwill appear

Pleasenotethat the renameoperationrequiresan SSH SecureShell sener version2.2.0(or later). Earlier
SSHSecureShellsenerversiongdo not supportherenameoperationandusingthis optionwill producethe
Error Renamingd-ile message for moreinformation,seesection9.9 (Error Renaming).

7.5.10 Properties

Selecffirst afile from the File Transferwindow andthenthe Propertieoptionto view thefile properties.

You canalsoview a file's propertiesby clicking on thefile with the right mousebutton. A shortcutmenu
containingthe Propertieoptionwill appearYou canselectmultiple files andview their properties.

For moredetailsaboutthe Propertiedage,seesection5.11(File Properties).
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7.6 Window Menu

The Window menuallows you to openandclosedifferenttypesof windows.

7.6.1 NewTerminal

Selectthe New Terminaloptionto opena nev SSHSecureShellfor WorkstationsVindows client terminal
window. Thenew window isimmediatelyconnectedo thesameemotehostcomputeasthecurrentwindow,
saving you thetroubleof typing your passverd again.

Multiple windows to a singleconnectiorallow you to for exampledehug your codein onewindow, execute
it in anotherdisplayreferencanformationin athird oneandreadyour mail in a fourthwindow.

The sequencenumberof eachwindow is displayedon the window’s title bar, in front of the remotehost
computers name. For example,a secondwindow associateavith a connectionto a hostcomputercalled
remotewould displayas2:remote

To closeary extra windows whenyou no longerneedthem, click on the X-shapedclosewindow button
locatedonthewindow’stitle barontheupperight handcornerof thewindow. Do notclick ontheDisconnect
buttonor selectthe Disconnecbptionfrom the File menu,asthis would closethe connectiorin all windows
associateavith this particularconnection.

7.6.2 NewFile Transfer

Selectthe New File Transferoptionto opena new File Transferwindow. To make file managingaseasyas
possibleyou canopenanunlimitednumberof File Transferwindows.

The sequencaenumberof eachwindow is displayedon the window’s title bar, in front of the remotehost
computers name. For example, a third window associatedvith a connectionto a host computercalled
remotewould displayas3:remote

To closeary extra windows whenyou no longerneedthem, click on the X-shapedclosewindow button
locatedonthewindow’stitle barontheupperight handcornerof thewindow. Do notclick ontheDisconnect
buttonor selectthe Disconnecbptionfrom the File menu,asthis would closethe connectiorin all windows
associateavith this particularconnection.

7.6.3 NewExplorer

Selectthe New Exploreroptionto opena nev Windows Explorerwindow. The Windows Exploreris the
familiar Windows utility that canbe usedto managethe files andfoldersin your local computer.You can
have multiple Explorerwindows openat the sametime to malke file managemergasier

The New Explorermenuoptionis availableonly in the File Transferwindow.

SSHSecure ShellWindows Client (© 2000SSHCommunicationSecurityCorp



102 Chapter 7. Menu Reference

7.6.4 Close

SelectheCloseoptionto closethecurrentwindow. Otherwindowsareunafected evenif they areassociated
with the sameconnection.

7.6.5 CloseAll Others

Selectthe Closeall Othersoptionto closeall the other SSH SecureShell for Workstationswindows client
windows associateavith this particularconnection.

A singleconnectiorcanhave severalwindows open(suchasan SSHSecureShellfor WorkstationdVindows
client terminalwindow anda File Transferwindow). The CloseAll Othersoperationaffectsall the other
windows associateavith a particularconnection.

However, if youhave startedbther separat&SHSecureShellfor WorkstationaVindows clients,they arenot

affectedby this operation.CloseAll Othersonly affectsoneconnectiorandall of its associatedvindows,
but no other separateonnections.

7.7 Help Menu

TheHelp menuallows youto accesshehelpandcopyright information.

7.7.1 Contents

Selectthe Contentptionfrom the Help menuto view the helpasWeb pages A browserwill openandthe
HTML basecdhelpfileswill beloadedocally, from your own computer Thecontentpagewill appearClick
on achapteryouwantto explore,or click the Index link to seeanalphabeticalisting of keywords.

If youwantto checkthe Web help insteadof the locally installedhelp files, seethe SSH SecureShell for
WorkstationsVindows client Web help: http://www.ssh.com/products/ssh/winhe Ip/ .

7.7.2 GetHelp On

Selectthe GetHelp On optionto changethe mousepointerto a help pointer. You canusethe help pointer
to click on buttons,menuitemsor otherdetailsof the userinterfaceto seecontet sensitve help on ary
particularitem.
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7.7.3 SSHonthe Web

Selectthe SSHon the Web optionto opena submentwcontainingWeblinks to SSHSecureShellWeb pages.

Online Help

Selectthe Online Help optionto load the Web versionof the SSH SecureShell for WorkstationswWindows
client help (http://www.ssh.com/products/ssh/wi nhelp /). Thisis usefulif you wantto see
themostup-to-dateversionof the help.

Frequently Asked Questions

Selectthe FrequentlyAsked Questionptionto load the online versionof the SSHSecureShell for Work-
stationswindows client FAQ (http://www.ssh.com/products/ssh/faq .html ).

Home Page

Selectthe HomePageoptionto openthe SSHCommunicationSecurityhomepage(http://www.ssh.
com).

7.7.4 Troubleshooting

Selectthe Troubleshootingption to displaythe Troubleshootinglialog. If you encounteproblemswhen
usingthe SSHSecureShellfor WorkstationdVindows client, you cansenda bug reportby usingthe support
web form at http://www.ssh.com/support . To male the supportteams work easier you should
describeyour systemandthe problemsituationas carefully aspossible. The Troubleshootinglialog helps
youin this.

Click the Copy to Clipboardbuttonto copy the troubleshootingeporton the Windows clipboard. You can
thenpaste(Ctrl+V) thereportinto the supportwebform. But pleasedescribeyour problemalsoin yourown
words- the Troubleshootinglialogcannotdo thatfor you!

7.7.5 Import LicenseFile

With the Import LicenseFile option you canregisteryour copy of the SSH SecureShell for Workstations
Windows client.

After you have appliedfor a licensefile from the SSHe-commercaveb site (http://commerce.ssh.
com) andreceved a licensefile (which is called license.dat by default), selectthe Import License
File menuoptionfrom the Help menu. You will be presentedvith a dialog requestinga file name.Locate

SSHSecure ShellWindows Client (© 2000SSHCommunicationSecurityCorp



104 Chapter 7. Menu Reference

Figure7.1: TheTroubleshootinglialog.

the license.dat file andclick the OK button. You shouldseea dialogtelling that the licensefile was
successfullymportedandcopiedto theinstallationdirectory.Click the OK buttonto continue.Your copy of
the SSHSecureShellfor WorkstationsNindows clientis now registered.

7.7.6 About Secuie Shell

Selecthe About SecureShelloptionto view thecopyrightinformationonthe SSHCommunicationSecurity
Corp’'s SSHSecureshellfor WorkstationdVindowsclient. Also versionandlicenseinformationis displayed.
Click the OK buttonto closethedialog.
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Figure7.2: The About dialogdisplayscopyright, licensingandversioninformation.
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Chapter 8

AdvancedInformation

SSHis a protocolfor secureremotelogin and other securenetwork servicesover aninsecurenetwork. It
consistof threemajorcomponents:

e Transportiayer protocol[SSH-TRANS]providessener authenticationconfidentiality and integrity.
It may optionally also provide compression.The transportlayer will typically be run over a TCP/IP
connectionput mightalsobe usedontop of ary otherreliabledatastream.

e Userauthenticatioprotocol[SSH-USERAJTH] authenticatetheclient-sideuserto thesener. It runs
overthetransporiayerprotocol.

e Connectionprotocol[SSH-CONN]multiplexesseverallogical channelsnto the encryptectunnel. It
runsoverthe userauthenticatiorprotocol.

The client sendsa servicerequesibncea securdgransportiayer connectiorhasbeenestablished A second
servicerequestis sentafter userauthenticatioris complete. This allows new protocolsto be definedand
coexist with the protocolslistedabove.

The connectiorprotocolprovideschannelghatcanbe usedfor a wide rangeof purposesStandardnethods
areprovidedfor settingup securénteractive shellsessionsindfor forwarding("tunneling”) arbitraryTCP/IP
portsandX11 connections.

8.1 SSH2Functionality

TheSSHSecureshellfor WorkstationdNVindows clientconnectandlogsinto thespecifiedemotehostcom-
puter Uponlogin, theusermustprove hisidentity to theremotehostcomputeby usingsomeauthentication
method.
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Public key authentications basedon the useof digital signatures Eachusercreatesa public / privatekey
pair for authenticatiorpurposes.The sener knows the users public key, but only the userhasher private
key.

Whenthe usertriesto authenticatderself,the sener sendsa challengeto the user Useris authenticatedhy
signingthechallengeausingthe privatekey.

Private/ public key pairscanbe createdwith a built-in key generatiorwizard. (Seethe section3.3.1 (key
generatiorwizard).)

Otherauthenticatioomethodscanbe usedaswell. If othermethoddail, the SSHSecureShellfor Worksta-
tionsWindows client promptsfor a passverd. Sinceall communicationss encryptedthe passvord will not
beavailablefor eavesdroppers.

Whenthe users identity hasbeenacceptedy the sener, the sener eitherexecuteshe givencommandor
logsinto the remotehostcomputerandgivesthe usera normalshell on the remotecomputer All commu-
nicationwith the remotecommandor shellwill be automaticallyencrypted.The sessiorcanbetransparent
andcanbeusedto reliably transferbinarydata.

The sessiorterminatesvhenthe commandor shell on the remotemachineexits andall X11 and TCP/IP
connectiondiave beenclosed.The exit statusof theremoteprogramis returnedastheexit statusof SSH2.

If the useris usingX11, the connectionto the X11 displayis automaticallyforwardedto the remoteside
in sucha way thatary X11 programsstartedfrom the shell (or command)will go throughthe encrypted
channelandthe connectiorto thereal X senerwill bemadefrom thelocal machine.

SSH2will alsoautomaticallysetup Xauthoritydataon the sener machine.For this purposeijt will generate
arandomauthorizatiorcookie,storeit in Xauthorityonthesener, andverify thatany forwardedconnections
carry this cookieandreplaceit by the real cookie whenthe connectionis opened.The real authentication
cookieis never sentto the sener machinglandno cookiesaresentin the plain).

If the useris usingan authenticatioragent,the connectionto the agentis automaticallyforwardedto the
remotesideunlessdisabled.

Forwardingof arbitrary TCP/IP connectionover the securechannelcanbe specified. TCP/IP forwarding
canbeusedfor secureconnectiongo electronicwalletsor goingthroughfirewalls.

SSH2automaticallymaintainsand checksa databaseontainingpublic keys of hosts. Whenlogging on to

a hostfor the first time, the host’s public key is storedto a file in the users personaldirectory. If a hosts

identificationchangesSSH2issuesawarninganddisablegpassverd authenticatioro preventfor examplea
Trojanhorsefrom gettingthe users passverd. Anotherpurposeof this mechanisnis to preventman-in-the-
middleattackswhich could otherwisebe usedto circumwenttheencryption.

SSH2alsohasbuilt-in supportfor SOCKSversion4 for traversingfirewalls.
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8.1.1 HostKeys

Eachsenerhostmusthave ahostkey. Hostsmayhave multiple hostkeys usingmultiple differentalgorithms.
Multiple hostsmaysharethe samehostkey. Every hostmusthave atleastonekey usingeachrequiredpublic
key algorithm.

The sener hostkey is usedduring key exchangeto verify that the client is really communicatingwith the
correctsener. For thisto bepossiblethe clientmusthave prior knowledgeof the sener’s public hostkey.

Two differenttrustmodelscanbe used:

e Theclient hasa local database¢hat associategachhostname(astypedby the user)with the cor-
respondingpublic hostkey. This methodrequiresno centrally administerednfrastructure,and no
third-party coordination. The downsideis that the databasef name-ky associationsnay become
burdensoméo maintain.

e Thehostname- key associations certifiedby a trustedcertificationauthority. The clientknows only
the CA rootkey, andcanverify thevalidity of all hostkeys certifiedby acceptedCAs.

The secondalternatve easeghe maintenancgroblem,sinceideally only a single CA key needsto
be securelystoredon the client. On the otherhand,eachhostkey mustbe appropriatelycertified
by a centralauthority beforeauthorizationis possible. Also, a lot of trustis placedon the central
infrastructure.

8.1.2 Security Properties

The primarygoal of the SSHprotocolsis improvedsecurityon the Internet.

¢ All encryptionntegrity, andpublic key algorithmsusedarewell-known, well-establishe@lgorithms.

¢ All algorithmsareusedwith cryptographicallysoundkey sizesthatarebelievedto provide protection
againseventhe strongestryptanalyticattacksfor decades.

¢ All algorithmsarenegotiated,andin casesomealgorithmis broken, it is easyto switchto someother
algorithmwithout modifyingthe baseprotocol.
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Chapter 9

Troubleshooting

If you shouldencounteran error messagavhen using the SSH SecureShell for WorkstationsWindows
client, pleaseeadtheerrormessagearefullyandfollow the suggestedourseof action. Somepossibleasrror
messageandtheir suggestedorrective actionsaredescribedelow.

9.1 Authentication Failure

Thiserrormessagendicateghattheauthenticatioprocesdetweeryourlocal computerandtheremotehost
computethasfor somereasorfailed.

Themostcommoncausédor failedauthentications anincorrectpassverd, likely causedy atyping mistale.
Also theusernamemaybeincorrect.Checkthatyou have typedit correctly

Onepossiblereasorfor authenticatiorfailureis thatthe remotehostcomputemay have beenconfiguredo
requireseveralauthenticatioomethodgo be used.For exampleboth passwerd andpublic key authentication
couldbe usedfor increasedsecurity Evenif you enteredyour passverd correctly someotherrequiredau-
thenticatiormethodcouldhavefailed. A relatively commonsituationis onewheretheremotehostcomputer
is expectingpublic key authenticatiorandyou have not sentyour public key to the host. You cando this by
following theinstructionsin section3.5 (UploadingYour PublicKey).

It may alsobe possiblethatyour accounton the remotehostcomputetasbeendisabledor thatthe remote
hostcomputeiis having temporaryproblemscausingerrorswith thelogin procedure.

Try to connectagainand carefully type in your usernameand passverd. If after a coupleof retriesyou
are surethatyou have enteredboth of themcorrectly contactthe systemadministratorof the remotehost
computer.
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9.2 Confirm Disconnect

This dialogis displayedwhenyou aredisconnectingan active connection.You caneitherconfirmthe dis-
connecbperationor cancelit.

Yes

Click the Yeshuttonto closethe currentlyactive connection.

No
Click theNo buttonto keepthe currentconnection.

Cancel
Click the Cancelbuttonto changeyour mind andabortthe disconnecbperation. This hasthe same
effectasselectingNo. (This optionis includedto make the selectiormoreintuitive for userswvho have
clickedthe Disconnecbuttonin error)

Help
Click theHelp buttonto view the help.

Note that one connectioncan have several windows open(suchas an SSH SecureShell for Workstations
Windows clientterminalwindow anda File Transfeiwindow). Disconnectingffectsall windows associated
with asingleconnectionAll tunnelsassociateavith thedisconnectedonnectiorwill beterminatecaswell.

However, if you have startebther separat&SHSecureShellfor WorkstationaNindows clients,they arenot
affectedby this disconnecbperation.Disconnectingjuitsoneconnectiorandall of its associateavindows,
but no other, separateonnectionsYou candifferentiatebetweendifferentwindows associateavith a single
connectiorby thewindow’s sequenc@umber displayedon thetitle bar

You candifferentiatebetweendifferentwindows associatedvith a single connectionby the window’s se-
guencenumberdisplayedonthetitle bar(seesectiord.1(TerminalWindow Title Bar)).

9.3 Confirm File Overwrite

The ConfirmFile Overwritedialogindicateghatafile you aretransferingalreadyexistsin thetargetsystem.
You canchooséf youwantto replacetheold file with the transferredile.

You have thefollowing options:

Yes
Click the Yeshuttonto replacethe old file.

Yesto All

Click the Yesto All buttonto replacethis file andalsoall the otherfiles thatalreadyexist in thetarget
system.
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No

Click theNo buttonto avoid overwriting the alreadyexisting file.

Cancel

Click the Cancelbuttonto abortthefile transferoperation.

9.4 ConnectionFailure

This errorindicatesthatthe SSHSecureShell client cannotestablisha connectiorto the remotehostcom-
puter Thereareseveralreasonghatmight causehis situation.

It may bethatyou have simply madea typing mistale, andthereis anerrorin the nameof the remotehost
computerIn this caseyou shouldalsoreceve anerrorstatingthatthe hostis unknown.

Checkthatyou have definedthe correctport numberfor the connection. The port canbe changedon the
Connectiorpageof the Settingsdialog.

Theremaybe problemswith the configurationor physicalsetupof the network connectionVerify thatother
network connectionsrefunctioning.

This problemmay also ariseif your local systemis protectedby a firewall andthe firewall hasnot been
properlyconfigured.If you suspecthatthis is the case askyour local systemadministratotto reconfigure
thefirewall.

Theremayalsobeatemporaryproblemwith theremotehostcomputer If thisis thecaseyoushouldwait for
awhile andtry to connectagainlater Contactthe administratoof the remotehostcomputerfor additional
information.

9.5 Disconnected:Authentication Err or

TheerrormessagéDisconnectedAuthenticatiorError (No furtherauthenticationmethodsavailable.)”indi-
catesthatary of the methodghathave beenusedto authenticatgouto the sener have not beensuccessful.

A relatively commonsituationis onewherethe remotehostcomputeiis expectingpublic key authentication
to beusedandyou have not sentyour public key to thehost. You cando this by following theinstructionsin
section3.5(UploadingYour PublicKey).

This error is also producedif the systems namesener is not doing reverselookupscorrectly Ask your
systemadministratotto configurethe namesener sothatit doesreverselookupsproperly

If this is not possible the systemadministratorhasto edit the file /etc/ssh2/sshd2 _config onthe
SSHsenerandchangahe RequireReerseMappingettingto no.
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Thisis acommonproblemfor modemconnectionsTypical modemconnectionsisedynamiclP addresses.
ThismeanghatthelP addresghange$rom oneconnectiorto anotherandthesedynamiclP addressekave
no permanenhamesener entriesin the DomainNameSystem(DNS). If this is the case you will have to
askyour serviceproviderto editthesshd2configfile onthe SSHsener.

9.6 Disconnection

This errorindicateshatthe connectiorto theremotehostcomputethasbeenlost.

Theremay be problemswith the configurationor the physicalsetupof eitheryour or the remotehostcom-
puters network connection.

It mayalsobethattheremotehostcomputehasbeenrebootedwhich hasdisconnectegour computerfrom
thehost.

Usually problemsof this kind aretemporaryandyou cantry againafterwaiting for awhile. If this doesnot

help, checkyour local network, andif necessarycontactalsothe systemadministratorof the remotehost
computer

9.7 Enter Passcode
You haveto enterthe passcodén orderto authenticatéhe connection Sometimest maybethatyou cannot
dothisimmediately but have to wait for thetokento change.

This messagappliesonly to SecurlDauthentication.

9.8 Enter Passphrasd-or Private Key
Thismessagéndicateshatthe remotehostcomputeiis willing to acceptyour publickey to authenticatgou
in thefuture.

Typein thepassphrasassociateavith this key. (You definedthe passphrasehenyou createdhepublickey
- seesection3.3.5(Key Generationr EnterPassphrasdpr moreinformation.)

If you just pressthe Enterkey, public authenticatiomwill notbe used,andthe systemwill askyouto typein
your passverd instead.
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9.9 Error Renaming

Thiserrormessagéndicateghatafile or folder on theremotehostcomputercould not berenamedUsually
this meanghatthe SSHsener softwareis too old to supportrenaming.

Therenameoperationrequiresan SSHSecureShellsenerversion2.2.0(or later). Earlier SSHSecureShell
sener versionsdo not supportthe renameoperation.Renamingemotefiles or foldersis not possibleuntil
the systemadministratoiof the remotehostcomputerupdateghe SSHsener software.

9.10 Evaluation Period Ending

Thismessag@ndicateghatthe evaluationperiodfor this copy of SSHSecureShellclientwill soonend.You
areallowedto usetheclientfor freefor thedurationof the evaluationperiod,andafterthatyou shouldobtain
alicensein orderto continueusingthe software.

For moreinformationon the licenseagreementreadthefile license.txtlocatedin the directorywhereSSH
SecureShellfor WorkstationsVindows clientwasinstalled.

Now it is a goodtimeto registerthe softwareto ensurehatyour network connectionsvill alwaysbesecure.
Thefastesindmostcorvenientway to obtainalicensefor your SSHSecureShell clientis to visit the SSH
e-commercevebsiteat http://commerce.ssh.com/

Thelicensingis aquickandeasyoperation.Thelicensefile is asmall,fastloadingfile thatyou candownload
immediately You canimport thelicensefile (license.datpy selectingthe Import LicenseFile optionfrom
theHelp menu.

You will be presentedvith a dialog requestinga file name. Locatethe license.dafile and click the OK
button. You shouldseea dialogtelling thatthe licensefile wassuccessfullymported. Click the OK button
to continue.Your copy of the SSHSecureShellfor Workstationds now registered.

Alternatively, if youwantto downloadthe newvestversionof thelicensedSSHSecureShellWindows Client
software,you candownloadthewhole packagewith thelicensealreadyinstalled.

Thankyou for evaluatingthe SSHSecureShellWindows Client!

9.11 Expiration
This errorindicatesthatthe evaluationperiodfor this copy of the SSH SecureShellclient hasended.The
client softwarecannotbe useduntil you obtainavalid license.

For moreinformationon the licenseagreementieadthefile license.txocatedin the samedirectoryasthe
SSHSecureShellWindows Client.
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Thefastestndmostcorvenientway to obtaina licensefor your SSHSecureShell clientis to visit the SSH
e-commercevebsiteat http://commerce.ssh.com/

Thelicensingis aquickandeasyoperation.Thelicensefile is asmall,fastloadingfile thatyou candownload
immediately You canimport thelicensefile (license.datpy selectingthe Import LicenseFile optionfrom
theHelp menu.

You will be presentedvith a dialog requestinga file name. Locatethe license.dafile and click the OK
button. You shouldseea dialogtelling thatthe licensefile wassuccessfullymported. Click the OK button
to continue.Your copy of the SSHSecureShellfor Workstationss now registered.

Alternatively, if youwantto downloadthe newvestversionof thelicensedSSHSecureShellWindows Client
software,you candownloadthewhole packagewith thelicensealreadyinstalled.

Thankyou for evaluatingthe SSHSecureShellfor Workstations!

9.12 Failed To CreateAn Incoming Tunnel

Thiserrorindicateshatthe systemhasnotbeenableto createtherequestedunnel.

The mostcommonreasonfor this failureis thata tunnelwith the samenamealreadyexists. The similarly
namedunnelmayhave beencreatedy anothetSSHSecureShellclient connectedo the samesener.

If thesystemhasseveralof SecureShellusersthey mayalreadyhave reseredsereralavailableports. In this
casgusttry againto find afreeport.

Anotherpossiblereasoris thatyou have no permissiorto opentherequestegbort. The systemadministrator
may have seta policy thatrestrictsopeningof communicationgorts- this is commonpracticeespecially
with incomingports. Checkthelocal policy from the systemadministrator Pleasenotethatonly the system
administratolroot) canopenportnumbersunder1024.

Pleasaotethatbothincomingandoutgoingtunnelsproduceheir own errormessagedf bothfail, theclient
will displaytwo separat@rrormessages.

9.13 Failed To ReadKeymapFile

This error messagéndicatesthat for somereasonthe SSH SecureShell for Workstationswindows client
is unableto readthe KEYMAP.MAP file. Whenthe SSH2client is startedfor thefirst time, it checksfor

the existenceof the keymapfile, andif the client doesnot find it, it copiesit to the currentusers personal
directory.

For easyaccesdo your personablatafiles, openthe Profile Settingspageof the Settingsdialogandclick the
Browsebutton.
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Checkthatthe KEYMAP.MAP file is in the correctfolder andthatits Read-onlyattributeis not set.

9.14 File OpenError

This errorindicatesthata configuratiorfile (suchasKEYMAP.MAP or default.ssh2)could not be properly
openedThefile maybedamagedor thefile maydefineanunknownn configurationvalue.

This errormayindicatethatyou areusinga configuratiorfile thatwascreatedusinganearlierversionof the
SSHSecureShellclient. You canremedythis by saving your configuratiorfile again(selectthe Save option
from theFile menu).

9.15 Host Ildentification

Whenyou connecto a remotehostcomputerfor thefirst time, the hostsendsyour local computerits public
key in orderto identify itself. To helpyouto verify the hostsidentity, the HostIdentificationdialogdisplays
a fingerprintof the hosts public key. The fingerprintis representedisingthe SSHBabbleformat, andit
consistof apronounceablseriesof five lowercasdettersseparatethy dasheslf you havereasorto suspect
thatthe public key you have recevedmaybeforged,you canfor examplephonethe systemadministratoiof
theremotehostmachineandcheckif thefingerprintis correct.

Youcansavethehostkey onyourlocalcomputeiby clicking the Yesbutton. Thisis therecommendedction.
If you sare the hostkey, youwon’t have to answetthis dialogagainwhenconnectingo the samehostfrom
thesamecomputer

If youdo notwantto save the hostkey, click theNo button. You canconnecthormally, but the next timeyou
connectto the samehost, the remotehostwill sendyou its public key andyou will againbe asled, if you
wantto save thekey onyourlocal computer

You canalsocancelthe connectiorattemptby clicking the Cancelbutton. This resultsin an authentication
failure,andthe connectiorwill be canceled.The hostkey is not saved andyour local computerwill not be
no connectedo theremotehostcomputer

9.16 Hostldentification Failed

Thiserrorsignifiesthattheidentificationmethodusedby the remotehostcomputerdoesnot matchwhatwas
expectedby the SSHSecureShellclient.

A changen thehostidentificationmay be causedy oneof thefollowing reasons:

e Theadministratoof theremotehostcomputetaschangedheidentificationmethod.
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e Theadministratorof the remotehostcomputethaschangedhe IP addresgor the hostname)of the
remotehost.

e Theadministratoof the remotehostcomputetasupgradedhe systemfrom SSHversionl senerto
SSHversion2.

e An intruderis trying to poseastheremotehostcomputer

If you encountetthis situation,do not proceedwith the connection! First you should contactthe system
administratoiof theremotehostcomputer(preferablyby phone)andcheckthereasorfor thefailedidentifi-
cation.Only proceedwith theconnectiorwhenyou aresurethatthe erroris not causedy anintruder

9.17 KeymapError

Thiserrorindicateshatthe SSHSecureshellclienthasnot beenableto reada keymapfile (KEYMAP.MAP
KEYMAP22 MARr OUTPUT.MAPthatdefineshow the keyboardinput/outputis processedThe keymap
file is eithermissing,corruptedor renamedvith anunrecognizabléle name.

Closethe SSH SecureShell client and checkthe keymapfile. If it is missingor corrupted,reinstall the
SSHSecureShellclient. The new installationwill leave your saved configurationsettingsintact, andafter
reinstallingyou cancontinueusingSSHSecureShellclientasbefore.

9.18 NewPIN

Entera newv PIN (PersonaldentifactionNumber)in orderto continue. Enterthe PIN twice, oncein each
field. This ensureghatyou have notmadeatyping mistale.

9.19 The RemoteHost UsesSSH1Protocol

Thismessagendicateghatyou areconnectingo aremotehostcomputethatis usingversionl of the Secure
Shellprotocol(SSH1).

Pleasenote that an SSH version2 (SSH2)is a more advancedprotocol than the legag/ versionSSH1.
For more information on using an SSH1 connection,seethe SSH web site http://www.ssh.com/
products/ssh/sshl.html

If you chooseo accepthe SSH1connectionmultiple terminalwindows andthefile transferoperationsare
notavailable.

If you do not want to seethis messagegain, selectthe appropriateSSH1 Connectionssettingfrom the
Securitypageof the Settingsdialog. For moreinformationon this option,seesection2.5.8(Security).
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9.20 WrongPassphrase

Thiserrorindicateghatthepassphrasgou entereds incorrectandthatthe privatekey file couldnotberead.
It alsopossiblethatthekey file hasbeendamagedbut thisis unlikely.

This error will resultin authenticatiorfailure (seesection9.1 (AuthenticationFailure)) and disconnection
(seesection9.6 (Disconnection))Click the OK buttonon botherrordialogsto continue.

Try to connectagain.If thiserroris repeatedyploadyour public key to theremotehostcomputeragain.For
moreinformationon this procedureseesection3.5 (UploadingYour PublicKey).

9.21 WrongPassword - Enter Again

This errorindicatesthat the passverd you typed doesnot matchwhat the remotehostcomputerexpected.
You have probablymadea typing mistale (or possiblyleft the passverdfield blank,whenthe hostcomputer
expectedo receve a passvord). Retypeyour password andhit the Enterkey to try again.

If afterseveralattemptsyou aresurethatyou have typedyour passverd correctly contacthe systemadmin-
istratorof theremotehostcomputer

9.22 Your LicenseHas Expired

This errorindicatesthatthe licensefor this copy of the SSHSecureShellfor WorkstationsWindows client
hasexpired. The client softwarecannotbe useduntil you obtaina new license.

For moreinformationon the licenseagreementieadthefile license.txiocatedin the samedirectoryasthe
SSHSecureShellWindows Client.

Thefastestindmostcorvenientway to obtaina licensefor your SSHSecureShell clientis to visit the SSH
e-commercevebsiteat http://commerce.ssh.com/

Thelicensingis aquickandeasyoperation.Thelicensefile is asmall,fastloadingfile thatyou candownload
immediately You canimport thelicensefile (license.datpy selectingthe Import LicenseFile optionfrom
theHelp menu.

You will be presentedvith a dialog requestinga file hame. Locatethe license.dafile and click the OK
button. You shouldseea dialogtelling thatthe licensefile wassuccessfullymported. Click the OK button
to continue.Your copy of the SSHSecureShellfor Workstationds now registered.

Alternatively, if youwantto downloadthe newvestversionof thelicensedSSHSecureShellfor Workstations
software,you candownloadthewhole packagewith thelicensealreadyinstalled.

Thankyou for usingthe SSHSecureShellfor WorkstationsAindows client!
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9.23 SSH1SpecificErr or Messages

Thefollowing errormessagenay be encountereevhenusingSSH1connection.

9.23.1 UnexpectedEOF

This errormessagéndicateshatthe connectiorto the senerhasbeenlost (literally meaninghatthe SSH2
clienthasencounterednunexpectedend Of File signal).
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Appendices

The SSH SecureShell for Workstationswindows client is shippedwith somecommandiine tools. Their
functionalityis briefly explainedin thefollowing appendices(For informationon thecommandine version
of SSH2 pleaseseesection3.7 ( Command_ine Options).)

Also includedis alist of answergo frequentlyasked questionsaiboutthe SSHSecureShellfor Workstations
Windows client.

10.1 SSH2

SSH2.EXE is acommandine versionof the
SSHSecureShell2 utility.

The syntaxof SSH2is:

ssh2 [options] [user@]host[#port] [command]

Thefollowing optionsareavailable:

-l user Log in using this user name.
+X Enable X11 connection  forwarding.
-X Disable X11 connection  forwarding.
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-i file Identity file  for public key authentication

-F file Read an alternative configuration file.

-t Tty; allocate a tty even if commandis given.

Y Verbose; display verbose debugging messages. Equal to -d 2

-d level Set debug level.

-V Display version number only.

-q Quiet; don't display any warning messages.

-c cipher Select  encryption algorithm. Multiple -c options are
allowed and a single -c flag can have only one cipher.

-m MAC Select MAC algorithm. Multiple -m options are
allowed and a single -m flag can have only one MAC.

-p port Connect to this port. Server must be on the same port.

-S Don't request a session channel.

-L listen-port:host:port Forward local to remote address

-R listen-port:host:port Forward remote port to local address
These cause SSH to listen connections on a port, and
forward them to the other by connecting to host:port.

+C Enable compression.

-C Disable  compression.

-0 ’option’ Process the option as if it was read from a configuration file.

-h Display this help.

Thecommandcanbeeitherof thefollowing:
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remotecommand [arguments ...]

Runcommandn remotehost.

-ssewice

Enableaservicein remotesener.

Type SSH2withoutargumentgo seethe commandine syntaxandthelocationof the configuratiorfiles.

10.2 SCP2

SCP2.EXEis aWindows portof the UNIX SecureCopy 2 tool (scp2).

SCP2is usedto securelycopy files overthe network. The programusesthe SSH2protocolfor datatransfer
andusesthe sameauthenticatiorand providesthe samesecurityas SSH2. SCP2will askfor passverdsor
passphrases they areneededor authentication.

Any file namemay containa host,userandport specificatiorto indicatethatthefile is to be copiedto/from
thathost. Copiesbetweertwo remotehostsarepermitted.

SCP2usesthe samehostkeys anduserkeys asthe graphicalSSHSecureShellWindows client. The default
locationfor thesefiles is the directoryusedto storethe userprofile. The-k switchcanbe usedto override
thedefaultlocation.

Pleasenotethat SCP2offersno fallbackto the SSH1protocol.
SYNOPSIS

scp2 [-D  debug_level]  [-d] [q] [Ql [-p] [u] [l [v] [-c cipher]
[[C] [P ssh2-port] [-f fw-name] [-F fw-port] [-k dir] [-V] [-h]

[[user@]host[#port]:]file ... [[user@]host[#port]:]file_or_dir

OPTIONS

-D debug_level_spec Set debug level. (Syntax is module=level)

-d Force target to be a directory.

-q Make scp quiet (only fatal errors are displayed).
-Q Don't show progress indicator.

-p Preserve file  attributes and timestamps.

-u Remove source files after  copying.

-r Recurse subdirectories.

-V Verbose mode; equal to -D 2.

-c cipher Select  encryption algorithm. Multiple -c options are

allowed and a single -c flag can have only one cipher.
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-C Sets compression on. Default is off.

-P ssh2-port sshd2 port.

-f  fw-name Firewall name.

-F fw-port Firewall port.

-k dir Store host keys and read user keys from this dir
instead of the wuser profile dir.

-V Display version.

-h Display this help.

Switchesaddedfor the Windows versionof SCP2are-C, -f ,-F and-k .

The Windows versionof SCP2doesnot readthe ssh2 _config file or ary otherconfigurationfiles. It
recevesall its parameterfrom thecommandine.

10.3 SFTP2

SFTP2.EXE is aWindows port of the UNIX Securerile Transfer2 tool (sftp2).

SFTP2is an FTP-like client that canbe usedfor file transferover the network. SFTP2usesSSH2in data
connectionssothefile transporis secure.

In orderto connectusingSFTP2 you needto make surethatsshd2s runningon the remotehostcomputer
you areconnectingo.

SYNOPSIS

sftp2 [-D debug_level spec] [-b  batchfile] [-S path] [-h]
[-V] [user@]host[#port]

OPTIONS

-D debug_level spec
Debug mode. Makes SFTP2 to send verbose debug output.
The debugging level is either a number (0-99),
or a comma-separated list of assignments
ModulePattern=debug_level.

-b batchfile
Batch mode. Reads commands from a file instead  of
standard input.  Since this mode is intended for

scripts, SFTP2 will  not try to interact with  the user,
which means that only passwordless authentication methods
will  work. In batch mode, a failure to change the current
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working  directory will cause SFTP2 to abort.

Other errors are ignored.

-S path

Specifies the path to the SSH2 binary.
-h Prints the command syntax and exits.
-V Prints  version information and exits.

user Specify the username to use when connecting.

(Optional)
host  Specify the host to connect
port Specify the port on the host

(Optional)

10.3.1 SFTP2Commands

to connect to.

WhenSFTP2is readyto acceptcommandsit will displaya prompt(sftp >). Theusercanthenenterary

of thefollowing commands:

open[host name |

Triesto connecto the specifiedhost.

localopen

Opensalocal connectionThisis intendedfor detuggingandtesting.

close

Closeshecurrentsession.
quit
Quitstheapplication.

cd [dir ectory ]

Changeshecurrentremoteworking directory

Icd [dir ectory ]

Changeshecurrentlocal working directory

pwd

Printsthe nameof the currentremoteworking directory

SSHSecure ShellWindows Client
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lpwd

Printsthe nameof the currentlocal working directory

Is[-R [-]] [file ..]]

Liststhenamef thefilesontheremotesener. For directoriesthecontentf thedirectoryarelisted.

Whenthe-R optionis specifiedthedirectorytreesarelistedrecursvely. (By default,thesubdirectories

of theargumentdirectoriesarenot visited.)

Whenthe-| optionis specifiedfile sizes modificationtimes,permissiongndowners(assupportedy

thefile system)arealsoshavn.

Whenno argumentsaregiven, it is assumedhatthe contentsof the currentdirectoryarebeinglisted.

Currentlytheoptions-R and- | aremutuallyincompatible.

s [-R [-]] [file ...]]

Thesameasls, but operate®n localfiles.

getffile ... ]

Transferghe specifiedfiles from the remoteendto the local end. Directoriesarerecursvely copied

with their contents.

mget(file ... ]
Synorymousto get.

put [file ... ]

Transferghe specifiedfiles from the local endto the remoteend. Directoriesarerecursvely copied

with their contents.

mput [file ... ]
Synorymousto put.

rename[source [target]]

Renameshefile sourceto target.

Irename[source [target]]

Sameasrenamehut operate®n localfiles.

rm [file ]

Triesto deletethe specifiedile.

Irm [file ]

Thesameasrm, but operate®n localfiles.

mkdir [dir ectory ]

Triesto createthe specifieddirectory

Imkdir [dir ectory ]

Thesameasmkdir, but operate®n localfiles.
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rmdir [dir ectory ]

Triesto deletethe specifieddirectory

Irmdir [dir ectory ]

Thesameasrmdir, but operate®n localfiles.

help [topic ]

If topicis notgiven,liststheavailabletopics.If topicis given,outputsthe availableonline helponthe
topic.

10.3.2 SFTP2Command Inter pretation

SFTP2understandbothbackslasheandquotationmarksonthecommandine. A backslasttanbeusedfor
ignoringthe specialmeaningof ary charactein the commandine interpretationlt will beremovedevenif
thecharacteit precedefiasno specialmeaning.

Quotationmarkscanbe usedfor specifyingfilenameswith spaces.

Also, if youdoget . orput . youwill getor puteveryfile in thecurrentdirectoryandpossiblyoverride
filesin your currentdirectory

SFTP2supportswild cards(alsoknown asglob patternsyivento commandss |, lls |, get , andput .

10.4 SSH-keygen2

SSH-KEYGEN2.EXHs aWindows port of the UNIX SSH2key generatiortool (ssh-lkeygen2).

Thessh-leygen2is atool thatgenerateandmanagesuthenticatiorkeysfor SSH2.Eachuserwishingto use
SSH2with public key authenticatiortanrun thistool to createauthenticatiorkeys. Additionally, the system
administratomay usethisto generatéostkeys for the SSHSecureShellsener.

SYNOPSIS

ssh-keygen2 [-b  bits] [t key_algorithm] [-c comment_string]
[-e file] [-p passphrase] [-P] [-\?] [-h] [[al [1 file] [-]
[-V] [ [-F file] [keyl key2 ..]

OPTIONS

-b  bits
Length of the key in bits, for example 1024 bits.
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-t key_algorithm

The algorithm used in key generation. Currently only
DSS (Digital Signature  Standard) is supported.
(In some distributions, RSA is, too.)

-c comment_string
Specify the key's comment string.

-e file
Edit the specified key. Makes ssh-keygen2 interactive.
You can change the key's passphrase or comment.

-p passphrase
Specify the passphrase used.

-P Specify that the key will be saved with an empty
passphrase.

-h | -\?
Print a short summary of ssh-keygen2 commands.

-q Hide the progress indicator.

-1 file
Convert key from sshl format to ssh2 format.

-V Print  version string and exit.

-r Stir in data from stdin to the random pool.

-F  file
Dump the fingerprint of a given publickey. The finger-
print is given in the Bubble Babble format, which
makes the fingerprint look like a string of "real"

words (making it easier to remember).

10.5 Frequently Asked Questions

TheFAQ givesanswergo someof themostfrequentlyasled questionsaboutSSHSecureShellfor Worksta-
tionsWindows client.
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10.5.1 Connectionlssues

DoesSSH Secuke Shellfor Workstations Windows client support connectingto an SSH1sewer?

Yes. But pleasenotethatthis is a terminalemulationcompatibility feature- this meanshat File Transfer
commandine SCP2andmultiple windowswill notwork whenconnectingo anSSH1sener.

When connecting to a host where | know | have an account, SSH2 says Di sconnect ed;
aut hentication error (No further authentication nmethods avail abl e.) (for
ssh-2.0.13server), or doesn't let me in, even when | type the correct password (for newer sewers).
What'swrong?

Theseneris probablytrying to checkthatthe hosthameyou gave it hasa DNS entry. Most dialup connec-
tionsdonothase a DNS entry.

In older SSH2 sener versions, the default /etc/sshd2 _config file had a statement
RequireReverseMapping yes. This should be changedto RequireReverseMapping no.
Ask your systemadministratoto changethis. If you still have problemsconsultyour systemadministrator

Doesthe SSH Secuie Shell for Workstations Windows client have support for host keys (to manage
public keysof multiple hosts)?

Yes,SSHSecureShellfor Workstationswindows client supportshostkeys. Selectthe Settingsoptionfrom
the Edit menu,and openthe Host Keys page(underGlobal Settings). Thereyou can setyour hostkeys
options.

10.5.2 File Transfer Issues

I’'m using SSH Secure Shell for Workstations Windows client. | can connectto the server and seethe
files on remotehost computer, but the Modified column is blank. | would lik eto be able to seethe last
modified time.

This is a problemwith the sener side of the software. Most likely the sener is running SSH SecureShell
senerversion2.0.13or earlier Pleaseaskyour systemadministratoto updatethe SSHSecureShellsener
softwareto resohe this problem.

Can | configurethe SSHSecure Shell for Workstations Windows client to openthe File Transfer win-
dow by default?

Yes- just openthe File Transferwindow, closeall terminalwindows andsave the settings(by selectingthe
Save optionfrom the File menu). Thenext time whenyou starttheclient, only the File Transfemwindow will
open.Whenyou savethesettingsthewindow positionsandtypesaresavedsoyou canhave ary combination
of windowsto openby default.
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10.5.3 Installation Issues

| haveinstalled the SSHSecure Shellfor Workstations Windows Client, and when| start the program,
several windows are opened.What is goingon?

Whenyou save your currentsettings alsothewindow positionsaresaved. If you startthe SSHSecureShell
client, opena new terminalwindow or two, andthen sare the settings,the 'extra’ terminalwindows will
appeawhenyou next time startthe SSHSecureShellclient. If you opentheFile Transferwindow andsave
your settingsthenext time alsothe File Transferwindow will appear

If you have too mary (or too few) windows openby default, or the window positionsarenot to your liking,
you canalwaysarrangethe windows asyou wantthemto appearandthensave your settings(by selecting
the Save optionfrom the File menu).Thenew window positionswill beusedwhenyou startthe SSHSecure
Shellclientagain.

How can| uninstall the SSHSecure Shellfor Workstations Windows client?

Openyour Windows Control Panel(by clicking the Startbutton andthenclicking the Control Paneloption
from the Settingsmenu).Doubleclickonthe Add/Remae Programscon, thenselectSSHSecureShell,and
follow thedisplayednstructions.

10.5.4 Licensinglssues

Do | haveto reinstallif | have beenusingan evaluation version and purchasethe software?

No, all youshouldneedto dois importthelicense.dat file. Thelicense.dat file turnsanevaluation
version(whichis basicallyjustthesamebinarywithoutalicensefile) into alicensedversion(eithercommer
cial or non-commercialdependingn the contentf thelicensefile). This meanghatyoudon't necessarily
needto downloadthe binary again,if you have beenevaluatingthe softwareandthendecideto purchasea
commercialor non-commerciallicense.This makeslife easielif you have a slow Internetconnection.

Usethe Import Licenseoptionfrom the Help menuto import thelicense.dat file into the SSHSecure
Shellfor WorkstationsNindows client. (Browsethedirectorytreeto selectthe appropriatdicense.dat
file).

10.5.5 Technicallssues

What ports doesthe SSHconnectionuse?
SSHconnectiorusesport 22 for the sener, ports1024andhigherfor theclient.
What type of terminal emulationis supported?

Theterminalemulationis compatibleup to vt320standardi.e. vt100,vt220,vt320,ansi[90%]) andis partly
xtermcompliant.
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Wherecanl| find alist of supported platforms for SSHSecure Shell?

Thelist of supportecblatformscanbe found at the SSHportability web page(http://www.ssh.com/
products/ssh/portability.html ).

10.5.6 Tunneling Issues

Can | tunnel X11 connectionsthr ough Secure Shell?

Yes.Performthefollowing stepsto forward X11 traffic:

1. InstallanX emulationprogram(for exampleExceedor Reflections).

2. SelectheSettingsoptionfrom theEdit menu.Selecthe Tunnelingpageonthe Settingdialog. Ensure
thatTunnelX11 Connectiongheckboxs checled.

3. Saveyoursettingsfor the SSHSecureShellfor WorkstationsWindows client.
4. Logoutof the SSHSecureShellWindows client,andlog backin.
5. Startthe X senerprogram.

6. Runxterm orxclock from SecureShell,andthe X11 forwardingshouldwork.
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file transfer12,40,66,118,124

file transfericon, 16

File Transfempage 34
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mission-criticaldata,11
modem,114
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Settingsoption,17,85,94
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